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Get Started 
Organizer Quick Start 
Follow along and you’ll be up and running in no time! 

Install GoToWebinar 
Once installed, you can start and schedule webinars with just a couple clicks. You can install 
GoToWebinar on your Windows or Mac computer, as well as your iOS, Android or Windows devices. 

The GoToWebinar desktop application is used to host webinars. 

• Download GoToWebinar 

Start a scheduled webinar 

You can also schedule webinars ahead of time using the desktop software, web account or our mobile 
apps. 

• Schedule a webinar 
• Start a scheduled webinar 

Explore GoToWebinar features and tools 
GoToWebinar is chock-full of cool communication features. Use the links below to learn more! 

• Connect to audio 
• Invite others to join 
• Share your desktop 
• Share your webcam 
• Send chat messages 
• Use drawing tools 
• Record sessions 
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How to Log In 
When you create a new account, or receive notification that you have a new Citrix account through your 
company, you can use your email address and password to access the applications. 

About Login IDs 
There are two types of logins for Citrix accounts (also referred to as your "account credentials"): 

• Citrix ID – These are users who access Citrix products directly using an email and password of 
their choice. This is the majority of accounts. 

• Company ID – These are users in a Single Sign-On (SSO) company framework, so they use their 
business username and password to log into Citrix. This type of login is only available if your 
system administrator has configured it for your account. If you're unsure, contact your system 
administrator. 

The Company ID accounts are currently a beta program. Release of the new capabilities is expected 
around June 30, 2015. To learn more about the beta program, contact signin-beta@citrix.com. 

For additional information on setting up Single Sign-On for your organization, see: 

• Set up Citrix WebSSO Integration 
• Provision accounts with Citrix Active Directory Connector 

Log in to your personal account 
1. Go to https://global.gotowebinar.com. 

2. Either enter your Citrix ID (i.e., the email address and password created during sign up), or if you 
are on a company SSO account, click Use My Company ID and enter your company username and 
password. 

You will be directed to the Citrix ID page by default; you can switch between login types by clicking the 
Use My Company ID link or I have a Citrix ID link. To have your information stored for the next 30 
days, enable the "Remember me" check box. 

IMPORTANT: Use My Company ID is only available if  your system administrator has configured it for your account. If  you're 
unsure, contact your system administrator. 
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3. Click Sign In. You'll then have access to all of the features and tools GoToWebinar offers! 

4. If you want to access your personal account settings once you are in the account, choose My 
Account from the options menu. 
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Log in to the Admin Center 
If you are an account administrator, you can log into the Admin Center directly. 

1. Go to https://admin.citrixonline.com. 

2. Either enter your Citrix ID (i.e., the email address and password created during sign up), or if you 
are on a company SSO account, click Use My Company ID and enter your company username and 
password. 

You will be directed to the Citrix ID page by default; you can switch between login types by clicking the 
Use My Company ID link or I have a Citrix ID link. To have your information stored for the next 30 
days, enable the "Remember me" check box. 

IMPORTANT: Use My Company ID is only available if  your system administrator has configured it for your account. If  you're 
unsure, contact your system administrator. 

3. Click Sign In.  

 

4. If you are an account administrator and you are also an organizer for one or more products (for 
example for GoToMeeting, you can also access the Admin Center from your options menu.  

 

© 2015 Citrix Systems. All rights reserved. 4 

https://admin.citrixonline.com/


GoToWebinar User Guide 

Trouble logging in? 
If you're having trouble logging in to your account, try the following: 

• You may be trying to log in with the wrong type of Login ID. Click the Use My Company ID link or I 
have a Citrix ID link, then try logging in again. 

• Are we lost? See why here. 
• Try resetting your password.  
• If you still can't log in, contact Citrix Support. 

Forgot your password? 
If you can't remember your password, you can reset it using your email address.  

1. Click the Forgot Your Password? link on the login page.  

2. Enter your login email address and click Continue to reset your password. 

3. Soon you’ll receive a Forgot Your Password email. Click the link inside to create a new password. 

 

4. You can also change your password from the options menu if you are logged in. 

Why are we lost? 
There are occasions when the Citrix authentication service cannot tell where you intended to go. This can 
happen, for instance, if you are already logged in and attempt to log in again. The page, You're not lost - 
we're lost, provides links to Citrix product accounts. If you do not have one of the products and click on 
the link, you are offered the opportunity to start a Trial account. 
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Don't have an account? 
Try GoToWebinar free for 30 days! Included in your 30-day free trial: 

• Unlimited online sessions 
• Up to 1000 attendees per session 
• Audio via telephone and/or mic and speakers 
• Free product training and 24/7 support  

Test your Connection, Audio or Webcam 
You can test your internet connection, audio connection and webcam at any time, whether you're getting 
ready to start a session or are already in one.  

Test your internet connection 

Before a session 

1. To test your connection from a computer or mobile device, join the test session using the following 
URL: https://www3.gotomeeting.com/join/406552062.  

2. You will automatically be launched into session.  

• Desktop users – If you have not yet installed the GoToWebinar desktop application, the download 
will automatically begin. See Install on Windows or Install on Mac for more information.  

• Mobile users – If you have not yet installed the GoToWebinar app, you will be directed to the app 
store to download it.  

3. If you see a "Waiting for Organizer" message, you've successfully joined the test session. You 
should be able to join GoToMeeting, GoToWebinar and GoToTraining sessions from this computer. 
Close the "Waiting for Organizer" dialog to exit the test session. 

Note: If  you're unable to join the session, you may not have all the necessary software. See Join Help for more troubleshooting 
tips, and make sure you have all the System Requirements.  
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During a session (Windows only) 

Does something feel off with your webinar session? You can test your GoToWebinar connection while in 
session to find out for sure. 

1. While in a session, open Preferences. 

2. Click Connection in the left navigation. 

3. Under "Test your GoToMeeting connection", click Test Connection. 

4. Under "Test Results", you'll see one of the following messages: 

• Passed: You've established a connection. 
• Fail: You haven't established a connection. See Connection Test Help for troubleshooting info. 
Note: You may need to enter your Window s username and password or domain if  you have a proxy that prevents you from 
connecting to GoToWebinar. If  you don't have a proxy, please check to see that you have the minimum system 
requirements.  

5. Click OK when finished. 
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Test your computer audio 

Before a session 

1. Right-click the daisy icon  in the system tray and select Preferences. 

2. Select Audio in the left navigation.  

3. Configure and test your audio as follows: 

• Use the drop-down menus to select which devices to use for microphone and speakers. If you do 
not see the device you're looking for, ensure that it is properly plugged into your computer.  

• If they are working as expected, you'll see the Mic meter  and Speakers meter  light up in 
green. If you do not see that happen, try selecting a different device.  

• If needed, click Play Sound to play a noise to test your speakers setup. 

4. Click OK when finished. GoToWebinar will remember your selection (unless the selected device is 
disconnected before the next session). 
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During a session 

1. You can use any of the following methods while in session: 

• Follow the instructions under Preferences > Audio, as described above. 
• Access the drop-down menus described above in the Audio pane of the Control Panel. 
• Click Sound Check in the Audio pane of the Control Panel, then use the Sound Check window to 

select your device and test the sound. If the audio isn't working as expected, try selecting 
another device that's connected to your computer from the drop-down menu until the audio 
indicators turn green. 
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Test your webcam 
You can test your webcam at any time to make sure everything looks the way you want it to. 

1. Right-click the daisy icon in the system tray and select Preferences. 

2. Click Webcam in the left navigation.  

3. If you have a webcam connected, you will see a preview of it under "Webcam Setup".  
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System Requirements 
Before you download the latest version of GoToWebinar, please check to see that your computer and 
accessories meet the minimum system requirements. Note that while most computers have built-in 
microphones and speakers, you will get much better audio quality if you use a headset. You can also 
make calls on your landline or mobile device. 

The following are required in order to use GoToWebinar: 
Desktop app 
Operating system 

Organizers and staff: 
 Windows 7 or later 
 Mac OS X 10.8 (Lion) or later 

Attendees: 
 Windows Vista or later 
 Mac OS X 10.8 (Mountain Lion) or later 

Internet  Recommended broadband connection with 1+ Mbps 
Web Browser 

Google Chrome v39.0 or later 
Mozilla FIrefox v34 or later  
Internet Explorer v8.0 or later 
Safari v6 or later 

Software GoToWebinar desktop app 
JavaScript enabled 

Hardware 2GB or more of RAM 
Microphone and speakers (USB headset recommended) 
Webcam (to use HDFaces) 

  

iOS app 
Operating system iOS 8 or newer 
Device iPhone 4 or newer  

iPad 2 or newer 
Internet WiFi recommended for VoIP audio 
Software 

Free GoToWebinar App from the App Store 

Hardware Headset recommended for VoIP audio 
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Android app   
Operating system Android 4.0 or higher 
Internet WiFi recommended for VoIP 
Additional software 

Free GoToWebinar App from the Google Play Store 

Hardware Headset recommended for VoIP audio 

  

Windows Phone & Windows 8/RT app 
Operating system Windows 8 or Windows RT 
Internet WiFi recommended for VoIP 
Software Free GoToMeeting App from the Windows Store 

  

Instant Join app 
Operating system Linux 

Google Chrome OS (Chromebook) 
Web Browser 

Google Chrome v39.0 or later 
Mozilla FIrefox v34 or later (Linux only) 

Internet  Recommended broadband connection with 1+ Mbps 
Hardware Microphone and speakers (USB headset recommended)  
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Manage your Account 
Forgot Your Password 
Remembering all your passwords is hard. Luckily, resetting your GoToMeeting password is easy. 

Forgot your password? 
1. Go to the Forgot Your Password? page.  

2. Enter your login email address and click Continue to reset your password. 

3. Soon you’ll receive a Forgot Your Password email. Click the link inside to create a new password. 

 

If you're still having trouble accessing your account, contact Global Customer Support.  

Can’t Access Your Account 
If you're trying to log in but can't access your account, your subscription may have expired. You'll need to 
first update your billing information to continue using GoToWebinar. 

Update your account 
1. Log in to your GoToWebinar account.   

2. You should be taken directly to the My Account page. In the Plan Details, click Subscribe Now to 
sign up for a paid subscription plan. 

3. Choose the plan that best fits your needs, and click Review Your Plan.  

4. On the Confirm Your Plan page, click Purchase Now. To ensure uninterrupted service, you will be 
billed automatically on the billing date. You can click Turn Off Renewal on the My Account page at 
any time to turn off automatic renewal. 

5. Once you confirm your plan, you'll be able to use GoToWebinar without any disruptions. 
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Change Your Login Info 
Have a new email address? Want to change passwords? No problem; just follow along.  

Change your login info 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Edit next to Login Info. 

4. To change your email address, edit your email address in the Email Address field. To change your 
password, enter your new password twice – it must contain 8 - 32 alphanumeric characters. 

5. Then enter your current password. If you forgot your password, click Forgot password? Enter your 
email address and reset your password by opening the link you receive in the Forgot Password email. 

6. When you’re done, click Save Changes. You’ll see a confirmation message saying that your login 
information has been updated. 
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Change Your Plan 
You can change your plan level at any time. Since your service is pre-paid, changes made to your plan 
won't take effect until the end of your subscription period.  

Note: If  you are the administrator of your account but are still unable to see some of the features and buttons described below , it is 
likely that you have an "off line" account (meaning that you manage your account and billing options through a Citrix Sales 
representative). In this case, you must contact Global Customer Support to modify your account and subscription plans. 

Change your subscription plan 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Change Plan in the Plan Details section. 

4. Select a plan that best fits your needs. To purchase a multi-seat account, select the number of 
organizer seats you need from the drop-down menu.  

5. Click Purchase Now. You can click Edit next to Plan Details or Billing Info to make any changes. 

Your plan will renew on your billing start date to ensure uninterrupted service. Your credit card on file 
will be automatically charged. Learn about how to turn off automatic renewal. 
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Edit Your Personal Info 
You can edit your personal info, such as your first and last name, primary language, time zone and 
daytime phone number. 

Edit your personal info 
1. Log in to your GoToWebinar account.   

2. Select My Account in the top navigation. 

3. On the My Account page, click Edit next to Personal Info. 

4. On the Change Personal Information page, you can edit your first or last name, primary language, 
time zone and daytime phone number (optional). You can also add your Twitter username to post 
questions about GoToWebinar and receive support. 

5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your 
personal information has been updated. 
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Update Your Billing Info 
You can change or update your billing info at any time. If you have a corporate account, follow steps 1 - 2 
below, and then click Contact Us in the Account Details section for Corporate Billing support. 

Change your billing info 
1. Log in to your GoToWebinar account.   

2. Select My Account in the top navigation. 

3. On the My Account page, click Edit next to Billing Info. 

4. On the Change Billing Information page, you can change your credit card information. 

5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your billing 
information has been updated. 

 

© 2015 Citrix Systems. All rights reserved. 18 

https://global.gotowebinar.com/


GoToWebinar User Guide 

Set Your Default Language 
You can set your default language for how you view the GoToWebinar website from the My Account 
page. After you've chosen your preferred primary language, you can view the GoToWebinar website in 
that language. You can also choose your preferred language while you're in-session – whatever language 
your operating system is set to is the default language for your in-session experience, but you can 
change that at any time from your Windows computer. 

Set your account's default language 
1. Log in to your GoToWebinar account.   

2. Select My Account in the top navigation. 

3. On the My Account page, click Edit next to Personal Info. 

4. On the Change Personal Information page, you can choose your primary language so that the 
GoToWebinar website appears in your preferred language. 

5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your 
personal information has been updated. 
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Choose your language in-session (Windows only) 

1. During a session, select the Globe icon  at the top of your Control Panel. 

2. Select your preferred language. You can switch languages at any time by selecting another 

language from the Globe icon . 

Updates to Your Account 
We’re in the process of rolling out updated versions of GoToMeeting, GoToWebinar and GoToTraining to 
our remaining customers who do not yet have the latest experience. As always, the updates are 
absolutely free. 

As part of this upgrade, we’re also combining your GoTo ™ product log-in credentials. If you use the 
same email address for GoToMeeting, GoToWebinar or GoToTraining and also for Open Voice and the 
GoToAssist family of products, you will need to complete a secure, one time password reset. This means 
one less password to remember, and it’ll be easier than ever to switch between some of our most popular 
solutions. 

Attend a live, online training session to learn more. Register today!   

GoToMeeting Updates 
Log in to your account at www.gotomeeting.com to get started.  

  

Schedule meetings even faster and easier:  

• Schedule and host meetings in localized languages such as French, German, Spanish, Italian and 
Mandarin. 

• Schedule and start your meetings directly from the website. 
• Designate a GoToMeeting organizer to host meetings on your behalf with the new meeting co-

organizer feature. Watch the Co-Organizer Basics video (3 min) to learn more! 

Personalize your meeting experience with new settings options:   

• Create brand awareness by uploading a custom logo to the GoToMeeting waiting room. 
• Select your default audio numbers, then set a preferred audio number so it conveniently appears 

first for attendees. 
• Enable a no download, Web App option, for attendees who are unable to download software or are 

using an unsupported operating system such as Linux. 
• Watch the Settings video (5 min) to learn more! 

Try our latest features and tools using Citrix Labs: 

• Try out GoToMeet.Me, one of our most popular new features. It’s a simple way for organizers to 
increase their professional presence online with a custom profile page and personalized meeting 
URLs to share with others. Try it today! 
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GoToWebinar Updates 
Log in to your account at www.gotowebinar.com to get started.  

   

Schedule webinars even faster and easier: 

• Schedule and host webinars in localized languages such as French, German, Spanish and Italian. 
• Create a webinar registration link in seconds with just a few clicks. 
• Watch the Scheduling Basics video (9 min) to learn more! 

Get more control over how attendees register and in-session interaction:   

• Add a splash of color to your event by selecting custom background, header and border colors for 
registration and confirmation pages. 

• Enjoy an increased capacity for polls (20) and survey questions (25), which means more attendee 
engagement. 

Learn more about your audience: 

• Use our new registration source tracking capability. 
• Get more details from your registrants with up to 20 custom registration questions. 

Improve vital email communication: 

• Re-send invitations to individuals and cancel registration on behalf of registrants as well. 
• Preview the automated webinar communication by sending yourself a copy of the confirmation and 

follow-up emails. 
• Improve the webinar's workflow by setting the “reply-to” email address to any email of your 

choosing. 

Leverage the content you create:   

• Review past webinars with archived recordings that will no longer expire. We’ll continue to store 
them so you can build out your content library. 

• Enjoy 3GBs of archived storage capacity for each webinar user at no additional cost. 
• Archive larger recording files with a new, increased upload limit of 1GB per recording. 
• Allow organizers on Macs to archive recordings. 
• Watch the Recording Basics video (4 min) to learn more! 
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GoToTraining Updates 
Log into your account at www.gototraining.com to get started.  

Schedule trainings even faster and easier: 

• Schedule and host trainings in localized languages such as French, German, Spanish and Italian. 
• Watch the Scheduling Quick Start video (3 min) to learn more.  

Easily manage your trainings with improved website usability 

• Quickly find content such as tests, materials, polls and co-organizers using the search function. 
• Generate reports to view training history. 
• Enable a no download, Web App option for attendees who are unable to download software or are 

using an unsupported operating system such as Linux. 
• Watch the Managing Libraries and Materials (9 min to learn more) 

Easily record your events and share them with your learners:  

• Immediately preview your newly added archived recordings directly from My Recordings. 
• Learn on the go with archived recordings viewable from any mobile device. 
• Allow organizers on Macs to archive any.mov or .wmv file. 

Corporate Admin Center Updates 

Log in to your updated administration center at www.gotomeeting.com and have a look around. See the 
Global Admin Center Guide for more information.  

Easily manage users and settings with improved search, filter and management functionality: 

• Create custom invitation templates to match your business processes. 
• Save time by creating default user settings for all new invitees. 
• Manage user settings even before the user accounts are activated. 
• Make settings changes in bulk for all users at the same time. 
• Assign seats, roles and groupings at the same time as well. 
• Create a localized user experience by setting the primary language. 
• Save important meeting links with the ability to reassign scheduled meetings to another user. 
• Select your default audio numbers, then set a preferred audio number so it conveniently appears 

first for attendees joining sessions. 
• Generate usage and bill reports for Open Voice Integrated services. 
• Add a custom field within your Settings options to track cost centers. 
• Watch the Global Admin Center Tutorial video (9 min) to learn more! 

Don’t forget to explore our additional integrations available to administrators, including the Active 
Directory Connector (ADC) and WebSSO (SAML 2.0). 
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Cancel or Renew Your Account 
Your plan is set to auto-renew, but you can turn that setting off any time. When you cancel your account, 
your service will continue until the end of your subscription period (since GoToWebinar is a pre-paid 
service). At that time your service will stop, you will lose access to scheduled sessions and reports and 
you will not be automatically charged again. You can renew your account at any time.  

Note: If  you are the administrator of your account but are still unable to see some of the features and buttons described below , it is 
likely that you have an "off line" account (meaning that you manage your account and billing options through a Citrix Sales 
representative). In this case, you must contact Global Customer Support to modify your account and subscription plans. 

Turn off renewal for free trials 
1. Log in to your online account.  

2. Select My Account in the top navigation.  

3. Click Change Plan in the Plan Details section.  

4. Select Cancel after my GoToWebinar Free Trial ends and click Continue.  

5. Click Cancel after Trial. You’ll see a message and receive an email confirming that you won't be 
charged after your free trial ends.  
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Turn off renewal for paid plans 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Turn Off Renewal in the Plan Details section. 

4. Click Turn Off Renewal. Your service will stop, and you will not be automatically charged after your 
plan ends. If you change your mind, you can log in at any time to restart your plan. 
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Renew your plan 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Renew Your Plan in the Plan Details section. 

4. If desired, click Edit to change your plan level. Then click Purchase Now. Your account will 
reactivate immediately! 

Note: You w ill be billed automatically on your billing start date.  
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Billing and Cancellation FAQs 
Review frequently asked billing and cancellation questions. 

How do I change my password? 
Have a new email address? Want to change passwords? See Change Your Login Info for more 
information.  

How do I cancel my paid subscription plan? 
Your plan is set to auto-renew, but you can turn that setting off any time. See Cancel or Renew Your 
Account for more information.  

If you're on a corporate plan, contact our Corporate Billing Center.  

How do I change my plan or switch products? 
You can change your plan level at any time. See Change Your Plan for more information.  

Can I change to a different GoToWebinar attendee tier without affecting my 
upcoming sessions? 
Yes, changing your plan will not affect your previously scheduled sessions. You can always switch to a 
higher attendee limit prior to your scheduled event. 

Log in to your account, and select My Account > Change Plan. Then select a plan and click Purchase 
Now.  

What charges apply when I change my plan? 
Plan changes will be automatically adjusted and pro-rated against your current account balance. We’ll 
send you a confirmation email receipt after the changes are completed. 

• If your new plan selection increases your subscription price, you’ll be prompted to enter payment. 
Once finished, you’ll have instant access to the features for the new plan. Your subscription billing 
date will change to reflect the date of the change in plan. 

• If your new plan selection decreases your subscription price, we’ll credit your account and apply 
the credit toward your next scheduled payment. Your subscription billing date will change to reflect 
the date of the change in plan. 

My account lapsed. How do I reactivate it? 
We’re glad you’re back! See Cancel or Renew Your Account for more information.  

How can I review the charges billed to my account? 
You can see your account history by logging in and viewing your recent billing activity at the bottom of the 
page. 
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How do I get answers to billing questions or request a refund? 
Contact Global Customer Support and we'll take care of all your questions and requests. 

Will I get a receipt for my purchase? 
You can see all your receipts by logging in and clicking My Account > View All Activity. We’ll also send 
a receipt via email for your first subscription purchase, subsequent renewals and any time you change 
your subscription plan. 

Preferences (Windows) 
The Preferences window allows you to modify the settings for running GoToMeeting (including audio, 
connection and integration settings).  

• Windows users can access Preferences by right-clicking the GoToWebinar daisy icon  in the 
system tray, or from the File menu while in-session. 

• Mac users can access Preferences by opening the GoToWebinar desktop application and 
selecting GoToWebinar > Preferences in the menu bar. Please see Preferences - Mac Users for 
more information. 

Start Up preferences 
These settings allow you to determine how GoToWebinar is launched and updated.  

• Start Automatically – Choose to have GoToWebinar automatically launch as soon as you log in 
to Windows. 

• Start Manually – Choose to have GoToWebinar wait until you manually launch it to open.  
• Remember me– Enter the login credentials for your account and choose whether GoToWebinar 

should remember them when you launch it.  
• Show me desktop notifications – Choose whether to allow GoToWebinar to show pop-up 

notifications regarding your account.  
• Remind me of upcoming meetings – Choose whether see pop-up notifications reminding 

you of upcoming meetings.  
• Automatically install updates – Choose whether to allow the GoToWebinar desktop application 

to automatically download and install new versions/builds when they become available (without 
prompt). 
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General preferences 
The General category lets you set your general GoToMeeting preferences. 

• File save settings - Enables you to save the Chat Log to any drive or directory. 
• Security - Set the inactivity timeout to automatically stop screen sharing if there is no keyboard 

input or mouse movement for the specified period of time. 
• Session Identity - Remember your name and email as displayed in the attendee list. 
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Meetings preferences 
The Meetings category lets you determine which GoToMeeting options are available to attendees during 
a meeting. You can also select which messages are viewable during a meeting. 

• Enable or disable the ability for attendees to chat and view the Attendee List. 
• Create a Chat Welcome Message that is sent to each attendee upon joining the meeting. 
• Enable or disable various system messages that appear to you when specific meeting actions 

occur. 
• Select the desired color for your GoToMeeting Viewer and Control Panel. 

Note: If  you disable the Chat Bubbles option, a new  message icon w ill still appear on the Grab Tab to notify you of new  chat 
messages as they are received. 
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Webinar preferences 

 

Training preferences 

 

© 2015 Citrix Systems. All rights reserved. 31 



GoToWebinar User Guide 

Recording preferences 
These preferences allow you to specify how sessions are recorded and where those recordings are 
saved.  

Note: Be sure to check your audio device settings under Audio. Mac users can only view  meetings recorded in the Window s Media 
Player format. 

1. Select Recording in the left navigation. 

2. In the Audio section, choose how you want the audio to be recorded: 

• Don't record audio: Records the presenter's screen only. 
• Use GoToWebinar audio service: Records everyone who speaks via VoIP or telephone. 
• Use your own audio service: Uses a microphone to record the organizer's voice, while a phone 

patch device will record everyone else who speaks (requires a physical input device).  
Using GoToMeeting 

Integrated Audio 
Using Your Own Audio Service 

Records all unmuted 
speakers in the 
meeting. 

To record all unmuted speakers, you will need a phone 
patch connected to both your phone and the mic in port of 
your computer. 

To record just your voice, you will need a microphone 
connected to your computer. 

If you want to use VoIP with your own audio 
service, please contact your Account Manager 
(GoToMeeting corporate plans) or Global 
Customer Support (GoToMeeting plans). 

Your Windows must have a sound card installed in order to record 
audio. For example, if you can hear music through your Windows, you 
have a sound card. 

3. All recordings must be converted before they can be played back. In the Recordings section, select 
whether or not to be reminded to convert recordings each time the session ends.  
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5. When your recordings are converted for playback, the recording files are saved to the Documents 
folder by default (C:\Users\<username>\Documents). You can select another folder by clicking 
Browse, navigating to the desired location and clicking Save. It is recommended that you choose a 
location on your hard drive.  

4. In the Preferences window, click OK.  

 

Recording preferences 
The Recording category lets you set your audio and video recording preferences. See Record a Meeting 
for more information. 

• Audio - Allows you to enable or disable recording the audio portion of your meeting. To record, 
choose which audio service you have scheduled to use for your meeting (see the following table). 

• Video - Allows you to select the meeting recording output format and destination for saving the file. 
• Save in - Select the folder in which you want to save your recording. 

Mac users are not able to record a meeting. If you want your meeting recorded, promote a Windows 
attendee to organizer in-session. A Windows-based organizer will have the recording feature. 
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Integration preferences 
The Integrations category lets you determine where to display GoToMeeting integrations. Options 
include: 

• Use GoToMeeting with - Select your GoToMeeting email and calendar integration. By selecting 
My default email application you can integrate with MAPI-compliant email/calendar programs other 
than Microsoft Outlook and Lotus Notes. Depending on your email application's capabilities, 
integration with MAPI-enabled programs allows for features such as automatically adding meetings 
to a calendar and automatic creation of email messages with meeting information. 

• Show GoToMeeting Toolbar in Microsoft Office - Display the GoToMeeting Toolbar in Microsoft 
Word, Excel and PowerPoint.  

Note: Changes w ill only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application. 

 

Connection preferences 
The Connection category allows you to test the status of your GoToMeeting connection. 

Note: To ensure a valid connection test, w e advise that you refrain from testing your connection unless a GoToMeeting Global 
Customer Care representative directs you to perform the connection test. 
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Audio preferences 
The Audio category lets you set up and test your microphone and speakers for recording and for your 
meetings utilizing VoIP. If changes to your audio settings are made during a meeting, your microphone is 
temporarily muted so you can privately manage your settings. See GoToMeeting Integrated Audio for 
more information. 

• Microphone Setup - Select a microphone from the drop-down menu. To test, speak into your 
microphone; if connected correctly, the sound bar will move when you speak. 

• Speakers Setup - Select your speakers from the drop-down menu. To test, click Play Sound; if 
connected correctly, the sound bar will move and you will hear a short soundtrack. 

• Advanced - GoToMeeting automatically adjusts system mixer settings. We recommend you keep 
this checked. If you uncheck this selection, you must manually configure your audio settings 
through Windows Sounds and Audio Devices. 

• Use automatic volume and noise processing - This option usually improves audio quality when 
people are talking. Unchecking this box may improve quality of music or other audio sources.  
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Webcam preferences 
The Webcam category lets you set up and test your webcam for HDFaces Video Conferencing. Options 
include: 

• Your camera - Shows the make and model of your detected webcam. 
• Select a display format - Adjusts the aspect ratios of webcam feeds. (4:3 is the normal display 

and 16:9 is the widescreen display. 
• Advanced - Modifies your hardware settings from within GoToMeeting. Customizable options 

depend on your webcam manufacturer. 
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Preferences (Mac) 
GoToMeeting Preferences allow you to set preferences for running GoToMeeting, choose where you 
want to store recordings, select what your attendees can see and set your webcam preferences.  

Mac users may access the GoToMeeting preferences by double-clicking the GoToMeeting Suite icon on 
their desktop and selecting Preferences from the GoToMeeting menu in the menu bar. 

 

General Preferences 
The General tab allows you store your account information and display name for meetings. If you check 
the "Remember me on this computer," your account information will be saved and you will not need to re-
enter it when you join a meeting. You can also select the "Use GoToMeeting with default email 
application" check box to add email integration to your GoToMeeting account. 

Recording Preferences 
The recordings tab allows you to choose where you would like to store your recordings and how you 
would like to be notified to convert your recordings (you must convert recordings before anyone can see 
them). 
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Meeting Preferences 
The Meetings tab lets you determine which GoToMeeting options are available to attendees during a 
meeting. Options include: 

• Enable or disable the ability for attendees to chat and view the Attendee List. 
• Create a welcome message that is sent to each attendee upon joining the meeting 

Webcam Preferences 
The Webcam tab allows you to select a camera to use for your wbecam as well as a display format. 
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Install and Upgrade 
Download GoToWebinar 
To get the most out of GoToWebinar you can download and install the full-feature desktop software on 
your Windows and Mac computer.  

Install on individual computers 
Windows and Mac users must install the GoToWebinar desktop software in order to host webinars from 
their computers.  

• Download the Windows/Mac version 
• Download the Windows 8/RT version 

For step-by-step instructions on downloading and installing the desktop software, see Install on Windows 
or Install on Mac. 

Install on mobile devices 
Mobile users can install the GoToWebinar free on iOS, Android or Windows devices. 

• Download the GoToWebinar app for iOS on the App Store.  
• Download the GoToWebinar app for Android on Google Play. 

Trouble downloading? 

For step-by-step instructions on downloading and installing the desktop software, see Install on Windows 
or Install on Mac. 

Trouble joining? 
If you're running into problems joining a session, see the following resources: 

• Join a Session 
• Join a Session FAQs 
• Join Help 
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Automatic Updates  
You can easily install the latest version of GoToWebinar whenever an update is available using the 
automatic updates feature. You won’t be prompted to install the latest version – you’ll simply get 
upgraded seamlessly when you’re not in session. By default, the automatic updates feature is enabled if 
you’re logged in to the application and have the “Remember me on this computer” option selected.  

Enable or disable automatic updates 
Note: If  you prefer to be prompted every 24 hours the next time an update is available, you may turn off automatic updates, but 
you’ll be required to go through the dow nload process. 

1. Right-click the GoToMeeting daisy icon  in your system tray and select Preferences. 

2. The default setting is to automatically install updates. If you wish to disable automatic updates, 
uncheck the "Automatically install updates" check box.  

You can click learn about our latest updates to see what’s new in the latest version. 
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Steps for Installing on Windows 
When you start or join a webinar, the installation package (including applications and plugins) will be 
downloaded onto your computer. By leaving the applications installed and the plugin enabled, you will be 
able to join future webinars more quickly by avoiding the extended download process. See Join Help for 
troubleshooting information.  

Note: These instructions apply to Window s customers only; also see Steps for Installing on Macs for more information. See 
Join Help for troubleshooting information.  

About the installation package 
The installation package includes the following components:  

• GoToWebinar desktop app 
This is the main software that you use to start and join webinars.  

• GoToWebinar Launcher app 
This "helper" application is required to install and launch the GoToMeeting desktop application. It 
must be installed on the computer, even if the GoToMeeting application is already installed. 
 Note: If  you remove the Launcher application at a later time, you'll need to go through the entire dow nload process again. 
We don’t recommend that you do this if  you frequently join w ebinars, as you will lose the benefit of faster join times.  

• Web Deployment browser plugin (optional)  
This plugin allows your web browser to automatically start the Launcher application, which in turn 
launches the GoToWebinar application. Although disabling or blocking the plugin will not prevent 
you from joining webinars, our products work best if the plugin is allowed to run when the browser 
prompts by clicking Allow, Run this time or Trust.  
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Download the desktop app 
1. Organizers can start a webinar (or attendees can join a webinar) to initiate the software download. 
Once the web browser launches, you will see the following:  

• If the Launcher application is not installed (either first time joining or it was removed), then 
the GoToWebinar Launcher.exe file will automatically start downloading. Continue to Step #2.  

• If the Launcher application is already installed, then some or all of the following steps will be 
skipped. The web browser will automatically start the Launcher app, which will then launch the 
GoToMeeting application (or install it again, if needed). The customer will not need to continue 
to Step #2, but they will see the dialogs described in Run GoToMeeting once installed.  

2. If the Launcher application is not already installed, then the GoToWebinar Launcher.exe file will 
automatically begin downloading. Depending on which web browser you are running, you can 
complete the download as follows: 

Mozilla Firefox®  

• Click Save File when prompted by the "Opening GoToWebinar Launcher.exe" dialog (click 
restart the download in the browser window if needed).  

 

• Click the Downloads button  in the toolbar, and then select the "GoToWebinar 
Launcher.exe" file.  

• Click Run if prompted.  
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 Google Chrome™ 

•  When the download finishes, click GoToMeeting Launcher file.exe at the bottom of the 
page to open the file (click restart the download in the browser window if needed).  

• Click Run when prompted.  
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Internet Explorer®  

• Click Run when prompted (click launch GoToMeeting again in the browser window if 
needed).  

 

3. The GoToMeeting Launcher application will be automatically installed, along with the Web 
Deployment browser plugin (click Yes if prompted by User Account Control). GoToMeeting will be 
automatically launched.  

 

Once the download is done, the customer will be able to join future webinars even faster! See Run 
GoToMeeting once installed for more information about joining future webinars.  

 Note: If  customers remove the Launcher application at a later time, they'll need to go through the entire dow nload process 
again. We don’t recommend that customers do this if  they frequently join support sessions, as they will lose the benefit of faster 
join times.  
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Run the desktop app once installed 

Once the Launcher application has been installed, customers will not need to download it again (unless 
they remove it). When these customers join a support session next, they will be prompted with additional 
dialogs from the web browser requesting permission to start the Launcher and/or GoToMeeting 
application on the customer's behalf. 

Mozilla Firefox 

If you are running Firefox, you may be prompted to choose an application to use (either the Citrix 
Online Launcher application, or the GoToMeeting application).  

1. Select the "Remember my choice for gotomeeting1468 links" check box to avoid being prompted 
by the dialog again when joining future sessions.  

2. Click OK to continue. The Launcher application will then start, as shown in Step #3 above.  
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Google Chrome 

If you are running Chrome, it may request your permission to open an external application (i.e., the 
Launcher application or the GoToMeeting desktop application) by prompting you with an "External 
Protocol Request".  

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by the 
dialog again when joining future sessions.  

2. Click Launch Application to continue. The Launcher application will then start, as shown in 
Step #3 above.  

 

Internet Explorer 

Customers running Internet Explorer v9 or newer will not be prompted by any additional dialogs. 
Customers running v8 or older will be prompted to manually launch the applications.  

1. Click Launch GoToMeeting in the web browser.  

2. Click Run in the Application Run dialog. The Launcher application will then start, as shown in 
Step #3 above.  
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Steps for Installing on Macs 
When you start or join a webinar, the installation package (including applications and plugins) will be 
downloaded onto your computer. By leaving the applications installed and the plugin enabled, you will be 
able to join future webinars more quickly by avoiding the extended download process. See Join Help for 
troubleshooting information.  

Note: These instructions apply to Mac customers only; also see Steps for Installing on Macs for more information. See Join Help for 
troubleshooting information.  

About the installation package 
The installation package includes the following components:  

• GoToWebinar desktop app 
This is the main software that you use to start and join webinars.  

• GoToWebinar Launcher app 
This "helper" application is required to install and launch the GoToMeeting desktop application. It 
must be installed on the computer, even if the GoToMeeting application is already installed. 
 Note: If  you remove the Launcher application at a later time, you'll need to go through the entire dow nload process again. 
We don’t recommend that you do this if  you frequently join w ebinars, as you will lose the benefit of faster join times.  

• Web Deployment browser plugin (optional)  
This plugin allows your web browser to automatically start the Launcher application, which in turn 
launches the GoToWebinar application. Although disabling or blocking the plugin will not prevent 
you from joining webinars, our products work best if the plugin is allowed to run when the browser 
prompts by clicking Allow, Run this time or Trust.  

 

© 2015 Citrix Systems. All rights reserved. 47 



GoToWebinar User Guide 

Download the desktop app 
1. Organizers can start a webinar (or attendees can join a webinar) to initiate the software download. 
Once the web browser launches, you will see the following:  

• If the Launcher application is not installed (either first time joining or it was removed), then 
the Citrix Online Launcher.dmg file will automatically start downloading. Continue to Step #2.  

• If the Launcher application is already installed, then the web browser will automatically start 
the Launcher app, which will then launch the GoToMeeting application (or install it again, if 
needed). You will not need to continue to Step #2, but you will see the dialogs described in Run 
the desktop app once installed.  

2. If the Launcher application is not already installed, the Citrix Online Launcher.dmg file will 
automatically begin downloading. Depending on which web browser you are running, you can 
complete the download as follows: 

• Apple Safari 
Double-click the "Citrix Online Launcher" file in the browser’s Downloads window  (click 
restart the download if the download doesn't start). 

 

• Mozilla Firefox® 
Select "Open with" then click OK when prompted (click restart the download in the browser 
window if needed).  

 

• Google Chrome™ 
When the download finishes, click Citrix Online Launcher file.zip at the bottom of the page to 
open the file (you may need to refresh the page and/or click download & run). 
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3. When the Citrix Online Launcher window opens, double-click the Launcher icon .  

 

4. You will see a message noting that "Citrix Online Launcher" is an application downloaded from the 
internet. Enable the "Don't warn me [...]" check box, then click Open to continue. The GoToWebinar 
application will then finish downloading and automatically launch. Once the download is done,you will 
be able to join future webinars even faster!  

 

See Run GoToWebinar once installed for more information about joining future webinars.  

 Note: If  you remove the Launcher application at a later time, you'll need to go through the entire dow nload process again. We 
don’t recommend that you do this if  you frequently join w ebinars, as you will lose the benefit of faster join times.  
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Run the desktop app once installed 

Once the Launcher application has been installed, you will not need to download it again (unless you 
remove it). When you next start or join a meeting, you will be prompted with additional dialogs from the 
web browser requesting permission to start the Launcher and/or GoToWebinar application on your behalf. 

• Apple Safari 
Users running Safari will not be prompted by any additional dialogs.  

• Mozilla Firefox 
If you are running Firefox, you may be prompted to choose an application to use (either the Citrix 
Online Launcher application, or the GoToMeeting application).  

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted 
by the dialog again when joining future webinars.  

2. Click OK to continue. The Launcher application will then start. 
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•  Google Chrome 
If you are running Chrome, it may request your permission to open an external application (i.e., the 
Launcher application or the GoToMeeting desktop application) by prompting you with an "External 
Protocol Request".  

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by 
the dialog again when joining future webinars. 

2. Click Launch Application to continue.  

3. Click Open when prompted. The Launcher application will then start. 
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Disable the Launcher Plugin 

Disable the Citrix Online Launcher plugin in Firefox on Windows 
1. Open Firefox. 

2. Select the Firefox menu > Add-ons. 

 

3. In the Add-ons Manager, find the Citrix Online Web Deployment Plugin. Click Disable. 

 

You can re-enable it again by clicking Enable. Please note that each time you download and execute 
the Citrix Online Launcher file, the add-on will automatically become re-enabled. 

Disable the Citrix Online Launcher plugin in Chrome on Windows 
1. Open Google Chrome, and type chrome://plugins/ into the address bar. 

2. Find the Citrix Online Web Deployment Plugin, and click Disable. 
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You can re-enable it again by clicking Enable. Please note that each time you download and execute 
the Citrix Online Launcher file, the add-on will automatically become re-enabled. 

Disable the Citrix Online Launcher plugin in Safari on Macs 
1. Open Finder and select the Go menu > Go to Folder. Or, press Command + Shift + G. 

2. Type ~/Library/Internet Plug-Ins and click Go. 

 

3. Delete the CitrixOnlineWebDeploymentPlugin.plugin by dragging it to the Trash on your Dock. 
You can also Ctrl + Click the plugin, and then select Move to Trash. 

You can restore it by dragging it out of the Trash, or you can Ctrl + Click the plugin from the Trash, 
and select Put Back. 

Once you remove the plugin from your Internet Plug-ins, it is removed from your Mac and from all 
other browsers on your computer. Please note that each time you launch GoToMeeting, the plugin will 
automatically become re-enabled. 
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Disable the Citrix Online Launcher plugin in Firefox on Macs 
1. Open Firefox. 

2. Select the Tools menu > Add-ons. 

3. In the Add-ons Manager, find the Citrix Online Web Deployment Plugin. Click Disable. 

 

You can re-enable it by clicking Enable. Please note that each time you launch GoToWebinar, the 
add-on will automatically become re-enabled. 

Disable the Citrix Online Launcher plugin in Chrome on Macs 
1. Open Google Chrome, and type chrome://plugins/ into the address bar. 

2. Find the Citrix Online Web Deployment Plugin, and click Disable. 

 

You can re-enable it again by clicking Enable. Please note that each time you launch GoToWebinar, 
the plugin will automatically become re-enabled. 
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Uninstall GoToWebinar 
When you start or join a session, the installation package that is downloaded onto your computer includes 
the following components: GoToWebinar desktop application, the GoToWebinar and the Web 
Deployment browser plugin. We don't recommend uninstalling any of the components of the installation 
package if you frequently start or join sessions, because they enable you to get into session faster. 
However, if you need to uninstall GoToWebinar, there are a few options for doing so.  

Uninstall manually (recommended) 
In order to completely uninstall all components of GoToWebinar, you will need to complete 3 steps: 

1. Uninstall the desktop app: The process for uninstalling a desktop application from a computer 
varies depending on the computer's operating system. See your operating system's user manual 
for more information.  

2. Uninstall the Citrix Online Launcher app: Follow the same process for uninstalling the Launcher 
app as you did for uninstalling the desktop app.  

3. Uninstall the Web Deployment browser plugin: Using Windows Explorer, go to 
C:\Users\<username>\AppData\Local\Citrix\Plugins\104 and delete the "npappdetector.dll" file.  

Example (Windows 7): Go to Window s Start  > Control Panel > Programs and Features. Right-click GoToWebinar and select 
Uninstall > Yes.  
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Uninstall via MSI (advanced) 
Domain administrators have the ability to automatically uninstall GoToWebinar from multiple users’ 
computers by configuring the Group Policy Object they used to install. To do this, they can do the 
following: 

WARNING: This method is not recommended, as some remnants may remain after un-installation (e.g., registry keys, shortcuts on 
the users’ desktops and Start menu items). This may cause major side effects and impact future installations of GoToWebinar. 

1. Before uninstalling user assigned GoToMeeting with a Group Policy, check that the "Start Manually" 
option is enabled from the GoToMeeting user preferences – and not "Start automatically after I log in 
to Windows" (which may result in an incomplete uninstallation).  

2. Go to GPO Properties. 

3. Select the Deployment tab and select the "Uninstall this application when it falls out of the scope of 
management" check box.  

Uninstall the Launcher application 
When you start or join a session, the installation package that is downloaded onto your computer includes 
the following components: GoToWebinar desktop application, the GoToWebinar and the Web 
Deployment browser plugin. We don't recommend uninstalling any of the components of the installation 
package if you frequently start or join sessions, because they enable you to get into session faster. 
However, if you need to uninstall the Launcher application (e.g., to do a clean re-install), you can 
following the directions below.  

The process for uninstalling the desktop application from a computer varies depending on the computer's 
operating system. See your operating system's user manual for more information.  

Example (Windows 7): Go to Windows Start  > Control Panel > Programs and Features. Right-click 
Citrix Online Launcher and select Uninstall > Yes.  
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Start, Schedule and Manage Webinars 
Schedule a Webinar 
Scheduling a webinar is easy! You can schedule webinars that occur once, weekly, monthly or, even 
those that have a custom schedule.  

Schedule a webinar 
1. Log in to your online account.  

2. Click Schedule a webinar (either on the My Webinars page or in the left navigation).  

 

  

3. On the Schedule a Webinar page, configure the details as follows: 

• Copy webinar 
Use this drop-down menu to schedule a webinar that's similar to one of your past webinars 
(including configured Polls, Surveys and emails). 
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• Title and Description 
This text will be used in your Invitation email and registration page, as well as displayed during 
the session itself.  

 

  

• Type 
Select the type of webinar you want to schedule: 
 

• One Session – Only one session will be scheduled; attendees register once to attend the 
session. 

• Series – Multiple sessions will be scheduled and made optional to attendees; attendees 
can choose which date(s) to attend when registering. 

• Sequence – Multiple sessions will be scheduled and made mandatory for attendees; 
attendees are expected to attend all session (but only need to register once). 

 

• Occurs 
If you select Series or Sequence, you can choose how frequently the webinar occurs, as 
follows: 

• Daily – Sessions occur consecutively every day from the start date to the end date. 
• Weekly – Sessions occur once at the same time and day every week. 
• Monthly – Sessions occur at the same time once a month by date or day (e.g., 1st of 

every month or first Wednesday of every month). 
• Custom Schedule – Webinar sessions do not occur in a regular interval.  

 

• Date/Time 
Select the start and end date(s) and start and end time(s) for the session(s). 
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• Webinar Time Zone 
Use the drop-down menu to select the time zone that the session will be held in. 

• Webinar language 
Use the drop-down menu to select the language that the session will be held in.  

 

4. Click Schedule when finished. You will automatically be taken to the Manage Webinar page where 
you can customize your new webinar.  
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Schedule a Similar Webinar 
If you already have a scheduled webinar that's set up with Polls, Surveys, emails, etc., you can schedule 
a similar webinar or copy a webinar so that all your settings and customizations carry over to another 
webinar. It makes it easy to schedule a webinar that's similar to one of your previously scheduled 
webinars.  

Schedule a similar webinar 
1. Log in to your online account.  

2. Find the past webinar that you want to copy in any of the following ways: 

• While scheduling a new webinar, use the Copy webinar drop-down menu at the top to select a 
previous webinar. 

  

• Open an upcoming or past webinar, then click Schedule Similar Webinar on the Manage 
Webinars page.  

 

• On the Past Webinars tab, click Copy next to the desired webinar. Only webinars with a start 
date within the past 90 days are displayed.  
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3. Configure the additional settings and date/time, then click Schedule. 

4. Any Polls, Surveys, emails and other settings configured in the previous webinar will be 
automatically be added. You will automatically be taken to the Manage Webinar page where you can 
customize your new webinar.  

Start a Scheduled Webinar 
You can start a scheduled webinar from either the GoToWebinar website or from the desktop app.  

Start from the web 
1. Log in to your online account.  

2. On the My Webinars page, click Start next to the session you wish to begin.  

3. The GoToWebinar desktop application will automatically begin downloading and launch you into 
session. See Control Panel and Grab Tab for information about the features and tools available to you 
while in a session.  

Note: See Control Panel and Grab Tab for information about the features and tools available to you w hile in a session. For help 
w ith the dow nload, see Steps for Installing on Window s or Steps for Installing on Macs. 
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Start from the desktop application 
If you already have the GoToWebinar desktop application installed, you can start the webinar directly 
from it.  

1. View your scheduled webinars as follows: 

• If the GoToWebinar desktop application is already running, right-click the GoToWebinar daisy 
icon in the system tray  (Windows) or top navigation (Mac).  

• If the GoToWebinar desktop application is not running, locate it on your computer and open it.  

 

2. Select My Webinars.  

3. A new web browser page will launch and open to your My Webinars page. Click Start next to the 
session you wish to begin.  

Note: See Control Panel and Grab Tab for information about the features and tools available to you w hile in a session.  
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Practice a Webinar 
If you're using a Windows computer, you can start a webinar in practice mode before you actually start 
the live webinar session. Attendees cannot join your practice session, but you can run through the 
webinar with other panelists and organizers to perfect it. If you practice a webinar up until the webinar's 
scheduled start time, you can easily start the live webinar while you're in practice mode. 

Start a practice webinar 
1. Log in to your online account.  

2. Begin the webinar in practice mode in either of the following ways: 

• On the My Webinars page, click Practice next to the desired webinar.  

 

• On the Manage Webinar page of the desired webinar, click Practice.  
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3. You will automatically be launched into session in practice mode, as indicated at the top of the 
Control Panel. You can also start a live webinar while in practice mode. 

Note: If  it has not yet been installed, the GoToWebinar desktop application w ill automatically begin dow nloading.  

 

Start a live webinar while in practice mode 
1. While the webinar is in practice mode, click Start at the top of the Control Panel.  

2. Click Start when prompted, or Continue Practice to remain in practice mode.  
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Customize Your Webinar 
After you've scheduled a webinar, you can customize the way that it looks and what options will be 
available to attendees.  

Access the customization page 
The Manage Webinar page allows you to customize your webinar to your liking: 

• You will automatically be directed to the Manage Webinars page each time you create a new 
webinar.  

• You can access the Manage Webinar page at any time by logging in to your account, clicking My 
Webinars in the left navigation and clicking the name of the desired session. 
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Edit the title and description 
1. On the Manage Webinar page, click Edit next to "Title / Description".  

2. Make your desired changes. 

3. If desired, enable the "Notify participants of these changes" check box. Then click Save.  
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Edit the date, time, timezone or language 
1. On the Manage Webinar page, click Edit next to "Date and Time". 

2. Make the desired modifications. 

3. If desired, click Add another session to add additional sessions to your webinar.  

4. If desired, enable the "Notify participants of these changes" check box. Then click Save.  
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Add another session to a webinar series or sequence 
1. On the Manage Webinar page, click Edit next to "Date and Time". 

2. Click Add another session, then select the date and time of new sessions.  

3. If desired, enable the "Notify participants of these changes" check box. Then click Save.  
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Add a session to your calendar 
1. On the Manage Webinar page, click Add to Calendar under "Date and Time".  

2. A new Outlook calendar item pre-populated with the webinar information will automatically start 
downloading. 

 

  

Cancel a session in a series 
You can cancel some or all sessions in a webinar at any time. See Cancel a Webinar for information. 
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Add co-organizers 
You can make someone a co-organizer before the session begins so that they can start the session if you 
are unable to.See Add Co-Organizers for more information.  
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Change the audio options 
1. On the Manage Webinars page, click Edit next to "Audio". 

2. Make your modifications as needed.  

3. If desired, enable the "Notify all participants of these changes" check box (this will not appear if the 
webinar does not yet have any registrants). Then click Save.  
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Customize the branding and theme for the webinar  
1. On the Manage Webinar page, click Edit next to "Branding and themes". 

2. Use the options to do the following: 

• Logo: Upload your own logo to increase attendee response rates. 
• Custom image: Upload an image to customize your theme. 
• Theme: Select a look and feel for the session.  
• Welcome message: Create a message that will automatically be sent to attendees once they 

join the session.  
• List presenters in the waiting room: If desired, add information about and/or a picture of the 

presenter that attendees will see as they are waiting for the session to begin. 
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Add panelists 
Panelists are members of webinar staff who can speak, present, share webcams and answer assigned 
questions during a session. You can either add panelists before a session starts, or promote attendees to 
panelists during the session.See Add Panelists for more information.  
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Share Webinars, Manage Registration and Send Emails 
Once you've scheduled and set up your webinars, you can invite attendees, manage registration and 
prepare emails and materials. 

Invite your attendees 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

3. On the Manage Webinar page, select Share on the top-left corner.  

 

Or, scroll down to the Share Your Webinar section, and select a delivery option: 

• Email Me the Invitation: Email the webinar registration info to yourself. Then send the 
invite to attendees.  

• Copy Webinar Information: Copy and paste the webinar registration information onto a 
web page, document or wherever you'd like. To select all the text shown, click Select All to 
highlight everything, and then copy and paste it by right-clicking the highlighted text and 
selecting Copy. Or, you can select the highlighted text and press Ctrl + C on your keyboard 
to copy and then Ctrl + V to paste it somewhere. 
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View the Registration URL and Webinar ID 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

3. On the Manage Webinar page, scroll down to the Share Your Webinar section where the 
Registration URL and Webinar ID is shown. You can click the Registration URL to see the registration 
form that your attendees see. 

Track registration sources 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

3. On the Manage Webinar page, scroll to the Share Your Webinar section and copy the Registration 
URL.  

4. Add the source to the end of Registration URL (e.g. 
https://attendee.gotowebinar.com/register/1751482784943615232?source=email). You can add 
sources to the Registration URL such as "?source=google", "?source=facebook" ,"?source=linkedin", 
etc. The source used cannot exceed more than 128 characters. 
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5. To view which sources registrants used to find your webinar, click Generate Reports in the left 
navigation and select Registration Report. 
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6. Select Generate Excel Report for the webinar you would like to track sources for. The Registration 
Report will display which source the registrant used. 

 

© 2015 Citrix Systems. All rights reserved. 77 



GoToWebinar User Guide 

Registration settings 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

4. On the Manage Webinar page, scroll down to the Share Your Webinar section. 

5. Click Edit in the Registration Settings section to manage registration. 

• Set a registrant limit 
• Add additional registration fields (first name, last name and email address are always required) 
• Create, edit sort or delete custom registration questions 
• Automatically or manually approve registrants 
• Set up registration notification emails 

Set Registrant Limit 

You can set a registrant limit so that no one can register for your webinar once the maximum amount 
of registrants has been reached. The registrant limit can be up to ten times your attendee limit (i.e., if 
your attendee limit is 100, then you could set your registrant limit up to 1,000). 

1. Enter a number within your registrant limit into the box under Webinar Size. 

2. Click Save. Once that many people have registered for your webinar, no one else will be able to 
register. 
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Add additional registration fields 

1. On the Manage Registration page, you can select additional required or optional registration 
fields for your attendees to fill out: 

• Address  
• City 
• State/Province 
• Zip/Postal Code 
• Country 
• Phone 
• Industry 
• Organization 
• Job Title 
• Purchasing Time Frame 
• Role in Purchase Process 
• No. of Employees 
• Questions and Comments 

2. Unless you select the "Required" check box next to each additional registration field, the added 
fields will be optional by default. 
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3. Click Save. You can click the Registration URL on the Manage Webinar page to see what your 
registrants will see. 
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Create, edit, sort or delete custom registration questions 

1. On the Manage Registration page, go to the Create Your Own Question section. You're 
prohibited from soliciting confidential personal information (credit card information, social security 
numbers, etc.) in your registration questions. 

2. Click New Question to create a registration question. 

3. Select the type of question: 

• Short Answer: Provides registrants with an open-ended answer. 
• Multiple Choice (One Answer): Gives registrants the choice of selecting one answer from 

multiple options available.  

4. Enter your question in the Question field. If you choose the multiple choice question type, enter 
at least 2 answers in the Answers field. If you want to add more than 3 answer options, click Add 
another answer.  

5. Click Create to save your question. 

• To edit your question, click the actual question on the Manage Registration page. After 
you've made changes, click Update. 

• To make your custom question required, select the "Required" check box next to the 
question on the Manage Registration page. 

• To delete your question, click the Remove icon  next to the question on the Manage 
Registration page. 

• To change the order of the questions, drag and drop a question up or down the list of 
questions on the Manage Registration page. 

6. Click Save.  

Automatically or manually approve registrants 

1. On the Manage Registration page, scroll down to the Approval section. 

2. Select 1 of the approval options: 

• Automatic Approval: Registrants will immediately receive information on how to join the 
webinar once they register. 

• Manual Approval: You must approve registrants before they receive information on how to 
join the webinar. 

3. If you'd like to receive an email every time someone registers, select the "Registration 
Notification" check box. If you don't select this option, you can return to the Manage Webinar page 
where you can click Manage or the registrant number link in the Manage Registration section to 
approve or deny registrants. 

4. Click Save.  

Direct registrants to a confirmation page 

1. On the Manage Webinar page, scroll down to the Registration Settings section. 

2. Click Edit next to Registration Settings. 

3.Select 1 of the following options: 

• Direct registrants to the GoToWebinar confirmation page: Registrants will see a 
standard GoToWebinar confirmation page. 
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• Direct registrants to your own confirmation page:  Enter the website you would like 
registrants to be directed to post-registration. 

 

4. Click Save to save your changes. 

Create a webinar password 

1. On the Manage Webinar page, click Edit next to Registration Settings. 

2. Select the "Create a webinar password" check box to require your attendees to enter a 
password before joining a webinar.  

3. Enter your password. You must send the password to your registrants or they won't be able to 
enter the webinar. For security reasons, GoToWebinar doesn't send the password for you. 

4. Click Save to save your changes. 
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Registration tracking 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

4. On the Manage Webinar page, scroll down to the Share Your Webinar section. 

5. Click View in the Tracking Registrants section: 

• Set the approval process 
• Set up registration notification emails 

Approve, deny or cancel registration 

1. On the Manage Webinar page, scroll down to the Registration Management section. 

2. Click Manage or the number of registrants to approve or deny registrants.  

3. On the Registrants page, select one or multiple registrants from the Pending Approval tab, and 
then click Approve or Deny.  

Approved registrants will receive a confirmation email and will be moved to the Approved tab on 
the Registrants page. You can still cancel their registration after they've already been approved, 
and they will be moved to the Deny tab.  

Denied registrants will be moved to the Deny tab, where you can still approve them if you 
change your mind.  

• To view a registrant's details, click the registrant's name on the Registrants page: 
• Status: Waiting Approval, Approved or Denied 
• Registered: Date that the person registered for the webinar 
• Email: Registrant's email address 
• Registration Answers: Submitted responses to custom registration questions 

• To export registration data to Excel, click Registration Report on the Registrants page. 
• To resend the confirmation email, click a registrant's name from the Registrant's page, 

and then click Resend Confirmation Email on the Registrant Details page. 
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Emails 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

4. On the Manage Webinar page, scroll down to the Email section. 

5. Click Edit next to the type of email you want to send. 

• Send confirmation emails to registrants 
• Send reminder emails to registrants and panelists 
• Send follow-up emails to attendees 

Send confirmation emails to registrants 

1. On the Manage Webinar page, scroll down to the Emails section. 

2. Click Edit in the Confirmation Email to Registrants section. 

3. On the Confirmation Emails page, you can choose if you want to send a confirmation email to 
registrants by selecting the "Send Confirmation Email to Registrants" check box.  

4. If you have selected the "Send Confirmation Email to Registrants" check box, you can then edit 
the email subject and enter custom text 

5. Click Save. You can view your changes in the Emails section on the Manage Webinar page. To 
preview how the email will look to registrants, select Preview. 

If you want to resend confirmation emails, return to the Manage Webinar page and click Manage 
next to Tracking Registrants. 

Send reminder emails to registrants and panelists 

1. On the Manage Webinar page, scroll down to the Emails section. 

2. Click Edit in the Reminder Emails section. 

3. On the Reminder Emails page, schedule your reminder email to be sent out to registrants and 
panelists by choosing one or more options: 

• 1 hour before the webinar start date and time  
• 1 day before the webinar start date and time  
• 1 week before the webinar start date and time 

You can select Send me a copy of the Reminder Email if you'd like to receive a copy as well. To 
preview how the email will look to attendees, select Preview.  

4. You can enter custom text in the provided field. You can customize reminder emails until they're 
sent to attendees. 

5. Click Save. You can view your changes in the Emails section on the Manage Webinar page. To 
preview how the email will look to attendees, select Preview.  
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Send follow-up emails to attendees and absentees 

1. On the Manage Webinar page, scroll down to the Emails section. 

2. Click Edit next to Follow-Up Email to Attendees. If you want to send follow-up emails to 
absentees (registrants who don't show up), click Edit next to Follow-Up Email to Absentees. 

3. On the Follow-Up Email page, select the "Send Follow-up Email to Attendees" or "Send Follow-
up Email to Absentees" check box. One follow-up email can be sent to attendees up to 7 days after 
the webinar's scheduled end date. 

4. Then choose when you'd like to send the follow-up email: 

• 1- 6 weeks after scheduled end date 
• 1-6 days after scheduled end date 
• 1-6 hours after scheduled end date 

You can select Send me a copy of the Follow-Up Email if you'd like to receive a copy as well. 

5. Enter the email subject and body text in the provided field to customize the email. 

6. Click Select a Recording to attach a recording to your email. You can upload recordings on the 
My Recordings page. 
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7. Click Save. You can view your changes in the Emails section on the Manage Webinar page. To 
preview how the email will look to attendees, select Preview.  
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Engage Attendees with Polls and Surveys 
You can engage your attendees by creating custom Polls and Surveys. You can create up to 20 Polls 
before the session or in-session on-the-fly and add up to 25 questions to a Survey. After you close a Poll, 
you can choose to show the Poll results immediately to everyone or at a later time during the session. 
Learn how to launch a Poll, show Poll results and create Polls in-session.  

Create, edit, sort and delete Polls before a session 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

3. On the Manage Webinar page, scroll down to the Engage Your Attendees section. Click Edit next 
to Polls. 

3. On the Create a New Poll page, choose the type of Poll: 

• Multiple Choice (One Answer) 
• Multiple Choice (Multiple Answers) 

4. Enter a question into the Question field. 

5. Enter at least 2 answers in the Answer field.  

6. Click Save.  

• To create another Poll for the session, click Edit on the Manage Polls page, and then click 
Create New Poll. You can add up to 20 Polls per webinar. 

• To view the Poll results, create an Attendee Report after the session ends. 
• To edit Polls, go to the Manage Webinar page, click Edit next to Polls and click the Poll 

question. Make your changes on the Edit Poll page, and then click Save.  
• To change the sort the order of Polls, go to the Manage Webinar page, click Edit next to Polls, 

and change the order of the polls on the Manage Polls page. Click Update Order when you're 
done.  

• To delete a Poll, go to the Manage Trainings page, click Edit next to Polls, and click the Remove 
icon  next to the Poll on the Manage Polls page. 
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Create, edit, sort and delete Surveys before a session 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

3. On the Manage Webinar page, scroll down to the Engage Your Attendees section. Click Edit next 
in the Surveys section. 

4. On the Survey page, enter a title for the Survey. 

5. Choose the Survey question type: 

• Multiple Choice with One Answer (2 or more answers are required) 
• Multiple Choice with Multiple Answers (3 or more answers are required) 
• Rate on a Scale of 1 to 5 
• Short Answer 

If you'd like to provide more than 3 answer options, click Add another answer.  

6. When you're ready to save your first question and answer, click Add to Survey. To add another 
question, click New Question on the Survey page. Repeat step 5 to add more questions to the 
Survey. 
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7. When you've completed creating your Survey, click Save.  

• To edit a Survey question or answer, click a question on the Survey page. Make your changes, 
and then click Save.  

• To change the order of Surveys, go to the Manage Webinar page, and click Edit next to 
Surveys. On the Survey page, drag and drop a Survey up or down in the list as you'd want it to 
appear to attendees. Click Save. 

• To delete a Survey, go to the Manage Webinar page, and click Edit next to Surveys. On the 
Survey page, click Delete Survey.  

• To preview a Survey, go to the Manage Webinar page, and click Edit next to Surveys. On the 
Survey page, click Preview to see how the Survey will appear to your attendees. 

 

© 2015 Citrix Systems. All rights reserved. 91 



GoToWebinar User Guide 

Choose when you want to send out a Survey 
Log in to your online account.  

2. Select My Webinars in the left navigation. Click the title of the webinar. 

3. On the Manage Webinar page, scroll down to the Engage Your Attendees section. Click Edit next 
in the Surveys section. 

4. On the Survey page, scroll down to the Settings section. 

5. Choose when you want to send out the Survey: 

• After the webinar: For a one-session webinar, the Survey is sent out after the webinar ends. For 
a webinar series, the Survey is sent out after each session ends. For a webinar sequence, the 
Survey is sent out after all sessions in the sequence have ended. 

• In the Follow-up Email: All registrants will receive a link to the Survey in the follow-up email. 

6. Click Save. You can view your changes in the Survey section on the Manage Webinar page. 

Related 

Upcoming Webinars 
You can get an overview of your upcoming scheduled webinars, as well as start your webinars from the 
My Webinars page. 

View upcoming webinars 
Log in to your online account.  

2. Select My Webinars in the left navigation. 

3. On the Upcoming Webinars tab, you can view all your scheduled upcoming webinars: 

• Date 
• Time 
• Title 
• Registrants 

You can hover over the Information icon  to get a glimpse of the webinar: 

• Title 
• Date 
• Scheduling Organizer 
• Registrants 
• Registration URL 
• Webinar ID 

You can also start a webinar from the My Webinars page by clicking Start next to a webinar. 
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Past Webinars 
You can view your previously held webinars that have ended and copy webinars from the My Webinars 
page. Past webinars will be displayed on the My Webinars page after the scheduled end time. If you 
recorded a webinar, you can go to the Past Webinars tab on the Manage Webinars page to edit the 
follow-up email to include the recorded webinar.  

View past webinars 
Log in to your online account.  

2. Select My Webinars in the left navigation. 

3. On the Past Webinars tab, you can view all your previously held webinars. If you click a webinar 
title, you can access the details for that webinar. 

 

Also, you can copy a webinar by clicking Copy next to a webinar so that you can schedule a similar 
webinar that includes the settings and customizations from one of your past webinars. 
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Cancel a Webinar 
You can cancel a webinar at any time. For a webinar series or sequence, you have the option of 
canceling either all sessions or individual sessions.  

Cancel all sessions in a webinar 
1. Log in to your online account.  

2. Select My Webinars in the left navigation, then open the webinar you wish to cancel.  

3. On the Manage Webinar page, click Cancel Webinar. 

 

4. You will be reminded that canceling the webinar will also revoke all of its registrants. Click Yes, 
Cancel Webinar to continue with the cancellation. 
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5. You'll be prompted to send a cancellation email to registrants. If desired, modify the subject and/or 
body of the email, then click Send. 

Note: You w ill not see this step if  you did not have any registrants for the session. 
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Cancel a session in a webinar (sequence) 
1. Log in to your online account.  

2. Select My Webinars in the left navigation, then open the webinar you wish to change.  

3. Click Edit in the Date and Time section.  

4. Click the Cancel icon  next to the sessions you wish to cancel.  

5. If you wish to notify the participants of the schedule change, enable the "Notify all participants of 
these changes" check box (recommended).  

6. Click Save when finished.  
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Cancel a session in a webinar (series) 
1. Log in to your online account.  

2. Select My Webinars in the left navigation, then open the webinar you wish to change.  

3. Click the Cancel icon  next to the sessions you wish to cancel.  

 

4. Click Yes, Cancel Webinar to continue with the cancellation. If the session has registrants, you will 
be reminded that canceling the webinar will also revoke all of its registrants.  
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5. You'll be prompted to send a cancellation email to registrants (if applicable). If desired, modify the 
subject and/or body of the email, then click Send. 

Note: You w ill not see this step if  you did not have any registrants for the session. 

 

Host a Webinar FAQs 
Review frequently asked questions on hosting a webinar. 

What can I do with GoToWebinar? 
With GoToWebinar you can easily set up, deliver and monitor large sessions and online events from 
anywhere at any time with up to 1,000 participants. 

• Registration: Target and screen your audience with a GoToWebinar registration page branded 
with your logo. GoToWebinar will manage your registrants for you and send email reminders to 
them before the session. 

• Presentation: Attract more audience members by presenting online and reducing travel costs. 
Engage your attendees with interactive Polls, Surveys and Q & A. 

• Reporting: GoToWebinar reports track attendance, audience feedback and overall success to 
help you develop best practices. 
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Do I have to be at my computer to host a session? 
You can host a session from a Windows or Mac computer with Internet access. 

• To start a scheduled session, log in to GoToWebinar. Your scheduled sessions will be listed 
under My Webinars – just click the Start button next to the session you want to start. 

• To host an instant session, click the Host a Webinar button on www.gotowebinar.com, and 
enter your account email and password. Then click the Webinar Now button. Your session will 
start immediately. To invite people to attend your session, click the Invite Others button in the 
Control Panel to send an invite or instruct attendees to join. 

• To schedule a session, log in to GoToWebinar, and select Schedule a Webinar from the left 
navigation. Enter a title and description, choose the session type, start date, start time, end time 
and time zone, and click Schedule.  

How do I schedule and set up a session? 

Log in to your account, and select Schedule a Webinar from the left navigation. Enter a title and 
description, choose the session type, start date, start time, end time and time zone, and click Schedule. 
On the Manage Webinar page, you can customize your session with branding, set up and manage 
registration, schedule follow-up and reminder emails and more. 

How do I start a scheduled session? 
Log in to your account. Your scheduled sessions will be listed under My Webinars – just click the Start 
button next to the session you want to start.  

How do I start an impromptu session? 

On a Windows computer, you can right-click the GoToWebinar daisy icon  in the system tray and 
select Webinar Now to start a session immediately. Once you're in-session, you can click Invite Others 
to invite other people (Webinar Now sessions can accommodate up to 200 people). 

What do I do if my attendees can't hear my voice or see my screen? 
Both audio and Screen Sharing need to be turned on once you start a session. 

• To enable audio for your attendees, press *1 on your telephone, or click the Start Broadcast 
button at the top of your Control Panel. (The Start Broadcast button appears when using Mic & 
Speakers and when you enter the Audio PIN while using the telephone.) 

• To enable Screen Sharing, click Show My Screen in your Control Panel. 

If attendees still can't hear your voice or see your screen, test your GoToWebinar connection. 
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Join Sessions 
Register for a Session 
If you'd like to attend a session as an attendee, you'll first need to register for the session using the 
Registration URL in your GoToWebinar invitation. After you register, you'll receive a confirmation email 
with information on how to join the session when it's time. 

Register to attend a session 
1. Open your GoToWebinar invitation email. 

2. Click the Registration URL to open the registration form. 

3. Fill out all required fields, including your first name, last name and email address. Then click 
Register. 

4. Once you've successfully registered, you'll see a Registration Confirmation page.  

• If the organizer sets up automatic approval, you'll immediately receive a confirmation email with 
information on how to join the session. 

•  If the organizer sets up manual approval, the organizer must first approve your registration 
before you'll receive a confirmation email.  

You can add a GoToWebinar appointment to your calendar as a reminder to join the session at the 
specified time and date. 

5. When it's time for the session, just click the Join URL in your confirmation email. Don't share the 
Join URL with anyone – it's unique to you.  

• If you're registering for a webinar sequence, you can use the same Join URL to join all sessions.  
• If you're registering for a webinar series (where you can choose which sessions to attend), you 

must use a different Join URL to join each session.The Join URLs will be provided in the 
confirmation emails that you'll receive for each session once you register. 

Join a Session 
You can join webinars from the web, desktop software or a mobile device! 

Join a session from a computer 
1. Access the webinar in any of the following ways: 

• Invitation email 
Select the Join URL in your Confirmation email. This will launch a new web browser page. 

Note: If  you have not yet registered for the w ebinar (and therefor have not yet received your Confirmation email), then you 
can click the Registration URL in your Invitation email to register for the active session. 
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• Web browser 
Open a web browser and go to the Join the Webinar  page. Enter the meeting ID (listed in your 
Invitation email), then click Continue. Enter the webinar ID (listed in your Invitation email) and 
your email address (optional), then click Continue.   

 

• Desktop software 
Right-click the daisy icon in the system tray  (Windows) or toolbar (Mac).  Select Join, enter 
the webinar ID (listed in your Invitation email), and click OK. 

Note: This method is only available if  you already have the GoToWebinar desktop software installed on your computer.  
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2. Depending on the organizer's account settings (as well as your operating system and web browser), 
you will be launched into session via the web app or via the desktop software. The desktop software 
will be automatically installed if needed. 

Note: If  you have not yet done so, you w ill f irst be prompted to register for the active w ebinar. 

3. Once you're in session, choose one of the audio options provided by the organizer to connect to the 
audio conference. You can choose your preferred audio option from the Audio pane of your Control 
Panel. 

Join from a mobile device 
1. Access the webinar in either of the following ways: 

• Invitation email 
Select the Join URL in your Confirmation email. This will automatically launch the mobile app 
(or the app store if you have not yet installed it onto your device).  

• Mobile app 
Open the GoToWebinar app, enter the webinar ID and select Join. Alternatively, you can select 
the scheduled webinar from the list that is imported from your phone's calendar (if available).  

 

2. You will be automatically launched into session. If you have not yet installed the mobile app, you 
will be instructed to do so. See the following articles for more information: 

• Download the GoToWebinar app for iOS on the App Store.  
• Download the GoToWebinar app for Android on Google Play. 
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GoToWebinar Instant Join 
Using the GoToWebinar Instant Join app, you can join webinars entirely within your web browser (rather 
than installing and using the GoToWebinar desktop app). This provides you with the following 
advantages: 

• You can get into session even faster than with the desktop app (great for when you're late joining!) 
• If you have software-installation restrictions (e.g., using a company computer or net kiosk), you can 

still quickly and easily join sessions. 
• You can easily switch to the full-featured desktop app if you want to use additional features. 
• If you are running an operating system that isn't supported by the desktop app (e.g., Linux, Google 

Chrome OS, Windows XP or older), you can join sessions entirely within your web browser.  
Note: Only attendees running Linux or Google Chrome OS w ill join via the Instant Join app. Attendees running Mac OS X 10.6 
(Snow  Leopard) will join via the Web View er, while Windows and Mac attendees can join using the desktop app. 

 

Instant Join features and tools 
You can use the following features and tools when you join a session from the Web AppInstantJoin. 

• Join instantly without going through a download or installation. 
• View the presenter's shared screen. 
• Connect to the audio conference using your computer's mic and speakers.* 
• Connect to the audio conference by dialing in via phone. 
• Raise your hand to get the organizer's attention.  
• Send chat messages to other attendees (either privately or to everyone). 
• Mute and unmute yourself (if enabled by the organizer). 

Note: The availability of these features depends on the attendee's w eb browser. Items marked w ith an asterisk (*) are only available 
to Linux and Google Chrome OS attendees using a Chrome brow ser. 
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Join a session via Instant Join 

When Web AppInstantJoin has been enabled, GoToWebinar will automatically detect the optimal join 
method for each attendee. 

• If you join from Linux, Google Chrome OS or Mac OS X 10.6 (Snow Leopard), then you will 
automatically join the session using the Instant Join app.  

• If you join from any other operating system, then the desktop app will automatically begin 
downloading and launch you into session.  

Connect to session audio 
The first time you join from the Instant Join app, your web browser will attempt to connect your mic and 
speakers to the audio conference. You must give the browser permission to access your mic and 
speakers in order to continue.  

• To enable the mic and speakers on Chrome, click Allow to continue. If you do not see the 
prompt, click the Video icon  in the Address bar.  

 

• To enable the mic and speakers on Firefox, click Share Selected Device when prompted (if 
needed, select the desired input device first). If you do not see the prompt, click the Mic icon  in 
the Address bar.  

Mute/unmute yourself 

You can easily mute or unmute yourself at any time by clicking the Audio button  in the right navigation. 
It will turn red  when muted and green when unmuted  (i.e., others can hear you).  

Note: You must f irst be unmuted by an organizer in order to unmute your mic during a w ebinar. 
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Switch audio modes (mic/speakers vs. phone) 
Note: Only attendees running Linux or Google Chrome OS and using a Chrome brow ser can use mic and speakers (VoIP). 

You can switch between using your mic and speakers (VoIP) and dialing in via phone at any time.  

1. Click the Settings icon  in the right navigation. 

2. On the Audio tab, select one of the following (depending on what options the organizer provided): 

• Computer Audio – Use the drop-down menu to select which device to use as mic and speakers.  
• Phone call – Use the drop-down menu to select which country's audio information should be 

displayed. 

 

© 2015 Citrix Systems. All rights reserved. 105 

https://www.google.com/chrome/browser/desktop/index.html


GoToWebinar User Guide 

Raise your hand 

Click the Hand icon  in the right navigation to alert the organizer. The Hand icon will glow green  
while it is raised, and will return to gray once it is lowered by you or by the organizer.  

 

Limitations of the Instant Join app 
While the Instant Join appallows attendees to use many of the same features and tools as the 
GoToWebinar desktop app, there are some features that are not supported.  

• Organizers cannot host sessions using the Instant Join app. 
• Attendees cannot be promoted to Presenter, panelist or organizer. 
• Attendees cannot take control of the presenter's mouse and keyboard. 
• Attendees cannot use drawing tools. 
• Attendees cannot view or share webcams. 
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GoToWebinar Web Viewer 
If you join a webinar from a Mac OS X 10.6 (Snow Leopard) computer, you will join the session directly 
from your web browser. This allows you to join webinars even though the GoToWebinar desktop app 
does not support OS X 10.6.  

Note: Only attendees running Mac OS X 10.6 (Snow  Leopard) will join via the Web View er. Attendees running Linux or Google 
Chrome OS w ill join via the Instant Join app, w hile all other attendees w ill join via the desktop app.  

 

Web Viewer features and tools 
You can use the following features and tools when you join a session from the Web Viewer: 

• Join instantly without going through a download or installation. 
• Connect to the audio conference by dialing via phone.  
• View the presenter's shared screen. 
• Mute and unmute yourself. 
• Send questions to the organizer. 
• Raise your hand to get the organizer's attention.  
• Change the language of the Web Viewer. 
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Connect to session audio 

When you first join the session, you will be prompted to dial in to the audio conference using your phone. 
You can use the drop-down menu to see the phone numbers provided for other countries.  

Once you have used your phone to dial in to the audio conference, click OK, I'm all set! to dismiss the 
message. You can access the audio information at any time during the session by clicking the Settings 
icon  in the right navigation and selecting Audio tab > Phone Call. 

 

Raise your hand 

Click the Hand icon  in the right navigation to alert the organizer. The Hand icon will glow green  
while it is raised, and will return to gray once it is lowered by you or by the organizer.  
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Send a question to the organizer 

You can send the organizer a question at any time by clicking the Question icon  in the right 
navigation. 

 

Change the language 

You can change the language of the Web Viewer at any time by clicking the Settings icon  in the right 
navigation, selecting the General tab and using the drop-down menu. 
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View limitations of the Web Viewer 
While the Web Viewer app allows attendees to use many of the same features and tools as the 
GoToWebinar desktop app, there are some features that are not supported. 

• Organizers cannot host sessions using the Web Viewer.  
• Attendees cannot be promoted to Presenter, panelist or organizer. 
• Attendees cannot take control of the presenter's mouse and keyboard. 
• Attendees cannot use drawing tools, participate in polls or answer questions. 
• Attendees cannot view or share webcams. 
• Attendees cannot switch to the desktop app. 

Join Help 
If you are having trouble joining a webinar, see below for some common troubleshooting information. For 
detailed instructions on installing a webinar, please see the Install on Windows and Install on Mac 
articles. 

I can't join a webinar. 
If you're having trouble joining a webinar, then try the following troubleshooting steps: 

• Make sure that you have gone through the join steps described in the Install the Desktop 
Application on Windows and Install the Desktop Application on Mac articles. These detailed 
instructions will ensure that all three components of the installation package are downloaded onto 
your computer, including the Launcher application, GoToMeeting desktop application and Web 
Deployment plugin.  

• Try uninstalling both the GoToMeeting desktop application and the Launcher application so that 
you can start fresh, then go through the join steps described in the Install the Desktop Application 
on Windows and Install the Desktop Application on Mac articles again.  

• How to Uninstall GoToMeeting from a PC 
• How to Uninstall GoToMeeting from a Mac 

• If that doesn't work, try rebooting your computer. Often this will resolve many issues you may be 
experiencing by resetting the current state of your software and starting over again. 

• If you still have trouble joining a meeting, please contact Citrix Customer Care. 

When I try to install GoToMeeting, nothing happens.  

If you're having trouble installing the GoToMeeting desktop application, then try the following 
troubleshooting steps: 

• The GoToWebinar application may be minimized or hidden behind other application windows. 
Check the Task Bar (Windows) or Dock (Mac) at the bottom of the screen for the GoToWebinar 
daisy icon, then click on it to expand the Viewer and Control Panel and see the in-session meeting.  

 

• If you're sure it didn't install properly, make sure you're following the steps for the specific web 
browser you're using. Please see the Install the Desktop Application on Windows and Install the 
Desktop Application on Mac articles for more detailed instructions about downloading with each 
web browser.  
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• When you install using Internet Explorer, you should see a prompt at the bottom of the 
screen that says "Do you want to run or save GoToWebinar Launcher.exe from 
download.citrixonline.com?". You'll need to click Run to continue. 

• When you install using Firefox, you should see one of the following pop-up windows: 
• If an "Opening GoToWebinar Launcher.exe" pop-up window asks you if you would 

like to save the file, you'll need to click Save File to continue.  
• If a "Launch Application" pop-up window asks you to choose an application, you'll 

need to click OK to continue.  
• When you install using Chrome, you should see one of the following options: 

• If no pop-up window appears, you should see a GoToWebinar Launcher.exe button 
appear at the bottom-left of the browser window. You'll need to click it to continue.  

• If an "External Protocol Request" pop-up window appears, you'll need to click 
Launch Application to continue.  

• When you install using Safari, you'll need to double-click the "Citrix Online Launcher" file 
in the browser’s Downloads window to continue.  

• If you have previously joined a meeting, webinar or training from the same computer, Internet 
Explorer may redirect you to the Connected to GoToWebinar page without showing the prompt at 
the bottom of the page. In this case, try clicking launch GoToWebinar again on the “Connected to 
GoToWebinar” page to prompt a manual download. If the page redirects to the GoToWebinar web 
app before you can click the link, try starting the webinar again.  

 

• The web browser version that you are using may be outdated and not supported by GoToWebinar 
(see the system requirements for more information). Try joining from another web browser, or 
update to a newer version of your current browser:  

• Update Internet Explorer 
• Update Mozilla Firefox 
• Update Google Chrome 
• Update Apple Safari 

• If you still have trouble joining a webinar, please contact Citrix Customer Care. 
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I can see the webinar on my computer but I cannot hear anything.  

You may not have the right settings selected for the type of audio that your organizer provided (i.e., 
dialing in via phone vs. using your computer's mic and speakers). Please see the Audio and Audio Help 
articles for more detailed information. 

I can hear audio from my computer but I cannot see anything. 
If you are hearing the audio of your session through your computer speakers but cannot see the 
presentation, the Viewer window is likely minimized. 

• The GoToWebinar application may be minimized or hidden behind other application windows. 
Check the Task Bar (Windows) or Dock (Mac) at the bottom of the screen for the GoToWebinar 
daisy icon, then click on it to expand the Viewer and Control Panel and see the in-session meeting.  

 

I get a "Could not Connect" error when I try to join a session. 
If you have a security program or firewall on your Windows computer that blocks connection with 
applications, you may need to manually enable GoToMeeting to join sessions. You may do this by 
opening your security software and accessing its firewall settings. Most security programs will allow you to 
configure access for specific programs in their firewall settings. To configure the firewall to allow 
GoToMeeting, look in the program rules for g2mcomm.exe and set it to “Allow” or “Full Access”. 

 

For more targeted assistance, please visit the support site of the manufacturer of the security program 
that you have installed on your computer: 

• avast! 
• AVG 
• Kaspersky 
• McAfee 
• Norton 
• Trend Micro 
• VIPRE 
• Webroot 
• Zone Alarm 
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I can't use GoToWebinar with a firewall, anti-virus program or anti-spyware. 

If you have a security program or firewall (such as Norton or McAffee) on your Windows computer that 
blocks connection with applications, you may need to manually enable GoToWebinar to join sessions. 
You may do this by opening your security software and accessing its firewall settings. Most security 
programs will allow you to configure access for specific programs in their firewall settings. To configure 
the firewall to allow GoToMeeting, look in the program rules for g2comm.exe and set it to "Allow" or "Full 
Access." 

Configure firewalls on your computer. 
1. Host or join a session to set off your firewall.  

2. When prompted to enable GoToWebinar to access the Internet, click Yes. Then select the 
"Remember the answer each time I use this program" check box.  

3. Open your anti-virus program to allow it to accept all GoToWebinar files. The following must be 
admitted via 1 of 3 ports: 80, 443 or 8200. One-way TCP connectivity is required (TCP outbound).  

g2m_download.exe G2MStart.exe G2MChat.exe 
AppCore.exe G2MLauncher.exe G2MQandA.exe 
G2MInstallerExtractor.exe G2MTesting.exe G2MSessionControl.exe 
G2MCoreInstExtractor.exe G2MMaterials.exe G2MMatchMaking.exe 
G2MCodecInstExtractor.ex
e 

G2MPolling.exe G2MRecorder.exe 

G2MInstHigh.exe G2MView.exe G2MTranscoder.exe 
G2MInstaller.exe G2MUI.exe G2MFeedback.exe 
G2MUninstall.exe G2MComm.exe G2MHost.exee 

Configure firewalls within a corporate environment. 

If you're using a firewall in a corporate environment, you may have a hardware firewall. Instruct your IT 
department to read the Optimal Firewall Configuration Fact Sheet to allow GoToWebinar to connect. 

Set up Norton® Anti-virus Software to allow GoToWebinar 

1. In your system tray,double click the Norton Internet Security icon . 

2. Select Open Norton Internet Security. 

3. From the Status & Settings menu, select Personal Firewall > Configure. 

4. Select the Programs tab to locate GoToWebinar, and then click Add. 

5. To begin adding files, select g2mcomm.exe > Open. 

6. When prompted, use the drop-down menu to select Permit > OK. Then repeat the steps for the 
remaining GoToWebinar files. 
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Set up Norton® Transaction Protection to allow GoToWebinar 
If your version of Norton Internet Security has the Norton Transaction Protection feature enabled, you 
may need to adjust your Norton settings before you can use GoToWebinar. 

1. If you haven't already done so, start and then end a GoToWebinar session. 

2. Right-click the Norton Internet Security icon  while it's visible in your system tray. 

3. Select Open Norton Internet Security. 

4. Select the Norton Internet Security tab at the top of the window. 

5. From the Settings drop-down menu, select Norton Internet Security Options > Transaction 
Protection. 

6. Change the status to allow "g2mlauncher.exe," and then click OK. 

Set up ZoneAlarm Firewall to allow GoToWebinar 

1. In your system tray, double-click the ZoneAlarm icon . 

2. Select Program Control > Programs tab > Add. 

3. On your computer, navigate to C:\Program Files\Citrix\GoToMeeting. Select all the GoToMeeting 
files, and click Open. 

4. Locate the GoToMeeting file in the Programs list. In the Trust Level column, click the Question Mark 
icon  , and select Super. Repeat this step for each of the GoToMeeting files. 

5. Finally, in the Access and Server columns, click each Question Mark icon  that corresponds to a 
GoToMeeting program, and select Allow. 

McAfee® Total Protection Anti-virus Software to allow GoToWebinar 

1. In your system tray, right-click the McAfee Total Protection icon .  

2. Select Open McAfee Total Protection. 

3. Then click Firewall > Settings.  

4. In the Program Permissions, scroll down and select GoToMeeting > Edit. 

5. Using the Access drop-down menu, select Full. Then click Save.  

Set up Kaspersky® Anti-virus Software to allow GoToWebinar 

Join a Session FAQs 
Review frequently asked questions on joining a session. 
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How do I register and join a session? 
When you receive a GoToWebinar email, click the Registration URL to register for the session. You can 
then join the session at the scheduled time in any of the following ways: 

• Click the Join URL in your confirmation or reminder email, which you received when you 
successfully registered for the session. 

• Visit the Join the Webinar page. Type or copy and paste the Webinar ID from your invitation email, 
and enter your email address.Then click Continue to enter the session.  

Do I need a GoToWebinar account to attend a session? 
No, you don't need a GoToWebinar account to attend a GoToWebinar session.  

What are the system requirements for attending a session? 
• Internet connection  
• Windows® 8, 7, Vista, 2003 Server or XP  
• Mac OS® X 10.6 (Snow Leopard®) or newer 
• iOS 6 or newer 
• Android 2.2 or higher 
• Internet Explorer® 7.0 or newer 
• Mozilla® Firefox® 4.0 or newer  
• Safari™ 3.0 or newer 
•  Google Chrome™ 

See the full  System Requirements for more information. 

Can I attend a GoToWebinar session from an iPad, iPhone or iPod touch? 
Yes, you can attend sessions on your iPad, iPhone, or iPod touch as an attendee only. You won't have 
the ability to share your screen if given presenter control. 

Can I attend a GoToWebinar session from an Android smartphone or tablet? 
Yes, you can attend sessions on your Android smartphone or tablet as an attendee only. You won't have 
the ability to share your screen if given presenter control. 

Can I view presentations in full-screen mode? 
Yes. On the top of the Attendee Control Panel, select the View menu > Full Screen. Or, you can click 
the View button on the Grab Tab to toggle between Full Screen and Window mode. 
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In-Session Features 
Control Panel and Grab Tab 
The control panel appears on the right side of your screen when 
you start or join a session. To free up space on your desktop, 
you can collapse the control panel and use the grab tab to 
continue to manage your session.  

Features & tools 
• Audience View 

View a thumbnail image of what attendees see when 
you share your screen. 

• Screen sharing 
Present a document, PowerPoint presentation or 
anything else on your computer. 

• Keyboard and Mouse Control 
Give keyboard and mouse control to an attendee so they 
can control your screen. 

• Change Presenter 
Allow someone else to show their screen. 

• Recording 
Record the presenter's screen, audio and shared 
applications during a session, then upload and store the 
recording for people to view. 

• Audio 
Use the audio pane to switch between telephone, mic & 
speakers and/or conference call numbers (if available). 

• Timer 
Display a timer to attendees to help facilitate timed 
assignments or discussions.  

• Dashboard 
Monitor the session at-a-glance and quickly view the timer, 
attendance, raised hands and more.  

• Attendee List 
View the names of all the meeting attendees. 

• Co-Organizers 
Make someone a co-organizer so they can share control 
the session with you.  

• Panelists 
 Make someone a panelist so they can speak and present 
during the webinar and answer assigned questions.  

• Drawing Tools 
Annotate directly on your screen to highlight, call out and 
draw attention to items on your screen. 

• Webcams 
Turn on your webcam to work face to face with attendees. 

• Invite Others 
Click to invite attendees during a session. 
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• Materials 

Upload documents, images and media files and add web links to your Materials so that attendees 
can review or complete tasks before, during and/or after a training in follow-up emails.  

• Polls 
Engage your attendees and focus their attention in-session. 

• Tests 
Create Tests that can be launched before, during or after a training.  

• Question and Answer 
Allow attendees to ask Questions to organizers during a session. 

• Leave and End a Session 
Leave or end a session anytime during the session.  
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Invite Others 
You can invite attendees to join your session either before or during the session.  Attendees who haven't 
registered must first fill out the required registration fields and submit the registration form before they can 
join the session that's already in progress. 

Invite attendees while in session 
1. In the Attendees pane, click Invite Others. 

 

2. Use the Invite Others window to invite an individual in any of the following ways: 

• Instruct the individual to go to www.joinwebinar.com and enter the Webinar ID listed in the 
window.  

• Click Email to launch a new email with the session information automatically populated, then 
send it to the individual. 

• Click Copy to Clipboard to copy the session information to your clipboard, then paste it 
wherever desired (such as an instant message to the individual). 

 

Invite attendees before a session 
1. Log in to your online account.  

2. On the My Webinars page, click Share next to the desired session. 

3. Select the desired method of inviting others (email, copy information, Facebook, etc.). 
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Share Your Screen 
You can share your screen during a session, which allows you to present a document, presentation or 
anything else you'd like to attendees. You can choose to share one or more of your monitors or even a 
single application. You can also show a clean Windows desktop to hide icons and the task bar, as well as 
blank out the background, so that the focus remains on the content you are presenting to your attendees. 

 

Share your screen 
1. To begin speaking to the entire audience, first click Start Broadcast; otherwise, only staff members 
will be able to hear you.In the Screen Sharing pane, use the drop-down menu to select the portion of 
your screen you would like to share: 

• Screen of main monitor, secondary monitor or both monitors – This shares the entire screen of 
one or both of your monitors (if more than one is configured). Be sure to close any windows you 
do not want to share before proceeding. 

• Screen of main monitor, secondary monitor or both monitors (CLEAN) – This shares your screen, 
but also hides your background, task bar and desktop icons. Be sure to close any windows you 
do not want to share before proceeding. 

• Application – This shares only the specific application that you select and hides the rest of your 
screen (available for Windows Presenters only). 

• Rectangle (Labs) – This shares only a specific portion of your screen, which you can choose my 
moving a floating frame around your screen. 

Note: Sharing w ith "Screen (Clean)" and "Rectangle (Labs)" are not available to Mac organizers. If  you w ish to share a 
Pow erPoint presentation on a Mac, you must f irst put the presentation into slide show  mode and then select "Pow erPoint Slide 
Show " in the Application w indow. If you do not, attendees w ill continue to see the main Pow erPoint w indow instead of the slide 
show , and they will not see your slides advance.  
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3. Click the Play button  to begin broadcasting your screen to attendees. You can change which 
part of your screen to share using the drop-down menu at any time.  

4. An "ON AIR - Showing screen" message will appear at the top of the Screen Sharing pane, and the 
Play button  will switch to Pause . 
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Pause/restart screen sharing 
Pausing screen sharing will freeze the image of the screen that attendees see.  

1. In the Screen Sharing pane, click the Pause button . 

2. A "Paused" message will appear at the top of the Screen Sharing pane, and the Pause button  
will switch to Play . To restart screen sharing, click the Play button . 

 

Stop sharing your screen 
When you stop screen sharing, attendees will see the Hallway again and a message that the organizer's 
screen is not being shared. 

1. In the Screen Sharing pane, click the Stop button .  
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Share Your Webcam 
You can share your webcams with other attendees using high-definition video conferencing. Up to 6 
different webcams can be shared during a session. All you need is an internet connection and a webcam 
to begin enjoying a telepresence-quality experience! 

Note: This feature is only available for staff members (Presenters, panelists and organizers).  
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Preview your webcam 
Put your best face forward and get ready for business! You can preview how others will see you, what’s 
around you or behind you, and ensure that others see only what you want them to see before your share 
your webcam. 

• Before you start sharing your webcam, go to Preferences > Webcam to see a preview. 
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Share your webcam 
There are multiple places on the Control Panel and Grab Tab where you can turn on your webcam, as 
follows: 

• In the Webcam pane, click the Share My Webcam button  or click the Webcams drop-down 
menu and select Share My Webcam. 

• In the Grab Tab, click the Webcam button  so that it turns green . 
• In the Attendees pane, right-click your name and select Share My Webcam or click the Webcam 

icon  next to your name. 
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Pause/restart sharing your webcam 
When you pause webcam sharing, other attendees will still see the webcam box with your name, but the 
screen will be blacked out until you resume sharing. This does not free up a webcam spot (e.g., if all 6 
webcam spots are filled, another attendee will not be able to start sharing their webcam). 

• Click the Pause icon  at the top of your webcam box in the Viewer. Click the Play icon  to 
restart sharing.  
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Stop sharing your webcam 
When you stop webcam sharing, your webcam box will disappear and the webcam spot will be freed for 
another attendee to share their own webcam. You can do so in any of the following places: 

• In the Grab Tab, click the green Webcam icon  so that it turns gray. 
• In the Webcam pane, click the Stop Sharing My Webcam button  or click the Webcams drop-

down menu and select Stop Sharing My Webcam. 
• In the Attendees pane, right-click your name and select Stop Sharing My Webcam or click the 

Webcam icon  next to your name. 
• In the Viewer, click the Stop icon  at the top of your webcam box in the Viewer.  
• In the Viewer, click the Webcams drop-down menu and select Stop Sharing My Webcam. 

See Share your webcam for information about restarting webcam sharing after it's been stopped. 

 

© 2015 Citrix Systems. All rights reserved. 127 



GoToWebinar User Guide 

Hide/show webcams 
Hiding webcams does not pause or stop webcam sharing; it simply hides the webcams currently being 
shared so that they do not take up space in the Viewer. Keep in mind that if you are sharing your webcam 
and then hide webcams, other attendees will still be able to see you.  

You can hide webcams in either of the following ways:  

• In the Webcam pane, click the Webcams drop-down menu and select Hide Webcams. 
• In the Viewer, click the Webcams drop-down menu and select Hide Webcams. 

  Use the same process and select Show All Webcams to display them again.  
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Start or stop webcam sharing for other attendees 
Note: This feature is available to organizers and co-organizers only. 

Organizers can send webcam requests to attendees in either of the following ways: 

• In the Attendees pane, click the Webcam icon  next to the attendee's name.  
• In the Attendees pane, right-click an attendee's name and select Send Webcam Request from the 

drop-down menu.  

 

Organizers can turn off attendee webcams in any of the following ways: 

• In the Attendees pane, click the Webcam icon  next to the attendee's name. Attendees will see a 
yellow tool tip or dialog indicating that the organizer has closed their webcam feed. 

• In the Attendees pane, right-click an attendee's name and select Stop Webcam Sharing. 
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Change Presenter 
The presenter has the ability to share their screen with other attendees during a session. As an organizer, 
you can make another attendee the presenter at any time (which does not cause them to automatically 
become an organizer).  Making an attendee a presenter automatically makes the attendee a panelist until 
the end of the session.  

Make an attendee Presenter 
1. Select a Presenter in either of the following ways: 

• In the Screen Sharing pane, click the 
Change Presenter button  and select 
the new Presenter. Note that only staff 
members will appear on this list. 

OR • In the Attendees pane, right-click the name of 
the desired attendee and select Make 
Presenter. 

 

  

 

2. Click Yes to confirm that you want to switch Presenters. You can also enable the "Request 
keyboard and mouse control" check box to have a request sent to the attendee before clicking Yes.  
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3. The new Presenter will be notified, and you will see a confirmation that you are no longer the 
Presenter. Attendees will see a "You've been made the Presenter" window prompting them to share 
their screen. 

 

Take back Presenter control 
You can resume Presenter control in the same way you passed it to another attendee: 

• In the Screen Sharing pane, click the Change Presenter button  and select yourself. 

- OR - 

• In the Attendee pane, right-click your own name and select Make Presenter. 

© 2015 Citrix Systems. All rights reserved. 131 



GoToWebinar User Guide 

Give Keyboard and Mouse Control 
When you are Presenter, you can grant other attendees shared control of your keyboard and mouse. This 
allows them to move the mouse about your shared screen and use their own keyboard to type on it, 
which can aid in collaboration.  

Of course, your mouse always has priority. You can always override another attendees' mouse 
movements to temporarily regain control without removing their access.  

Note: This feature is only available for staff members (Presenters, panelists and organizers).  

Share keyboard and mouse control with others 
Note: Attendees w ho joined via Web App must sw itch to the desktop app and then be promoted to Panelist to share keyboard and 
mouse control. Mobile attendees cannot use this feature. 

1. Share keyboard and mouse control in either of the following ways: 

• In the Screen Sharing pane, click the 
Give Keyboard and Mouse button and 
select the desired member of staff. 

OR • In the Attendees pane, right-click the name of 
the desired staff member and select Give 
Keyboard and Mouse. 

 

  

 

2. All attendees with keyboard and mouse control will have a Check icon  next to their name in both 
drop-down menus shown above.  
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Temporarily take control of your keyboard and mouse 
1. Simply type or move your mouse to re-gain control temporarily. The other person can continue to 
control your keyboard and mouse, but you will override their movements. 

2. Instruct the person with keyboard and mouse control to resume controlling your screen when you're 
finished. 

Remove keyboard and mouse control from others 
You can remove keyboard and mouse control in the same way that it was granted (e.g., selected from 
one of the drop-down menus). Once attendees have control removed, the Check icon  will disappear.  
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View and Manage Attendees 
The Attendees pane displays a list of all the participants in a session.  You can toggle between the 
Attendees tab and the Staff tab (which displays the names of organizers, presenters and panelists) to see 
who's in attendance.  

 

Attendees pane icon key 
The Attendees pane uses icons to describe the status of the attendees and staff members in your 
session.  

Audio icons 

 Individual is connected via VoIP and unmuted 
 Individual is connected via VoIP and has muted themselves 
 Individual is connected via VoIP and muted by organizer 
 Individual is attempting to connect via VoIP 
 Individual is connected via phone and unmuted 
 Individual is connected via phone and has muted themselves 
 Individual is connected via phone and muted by organizer 
 Individual is attempting to connect via phone OR they are connected but have not yet 
entered their audio PIN 
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Other icons 

 Individual is the current Presenter (staff only) 
 Individual has been given access to keyboard and mouse control 
 Individual is currently controlling the keyboard and mouse 
 Individual has a webcam connected (but is not sharing it) (staff only) 
 Individual is sharing their webcam (staff only) 
 Individual is not attentive (i.e., an application other than GoToWebinar is at the 
forefront of their screen) 
 Individual has asked a question 
 Individual has their hand raised 
 Individual has been given access to drawing tools 

Mute/unmute attendees 
By default, all attendees are automatically muted when they join the webinar. 

• To mute or unmute a single attendee, click the Audio icon next to their name. Plain green icons 
  represent unmuted attendees, while icons  with a slash through them represented muted 

attendees.  
• To mute all attendees, click the Mute All button at the bottom of the Attendees pane. 

 
Note: If  an organizer attempts to unmute attendees w ho have muted themselves, the attendees w ill be prompted to be automatically 
unmuted or to remain muted.  

Make an attendee Presenter 

The presenter has the ability to share their screen with other attendees during a session. As an organizer, 
you can make another attendee the presenter at any time (which does not cause them to automatically 
become an organizer).  Making an attendee a presenter automatically makes the attendee a panelist until 
the end of the session. See Change Presenter for more information.  

Make an attendee an organizer 
As the scheduling organizer of a session, you can allow other attendees to be co-organizers who can 
facilitate the session with you. You can either add an organizer before a session begins (which allows 
them to start the session on your behalf), or you can promote an attendee to organizer while in session. 
Co-organizers are able to access all the same session features as the scheduling organizer (however, co-
organizers who are promoted during a session will not have access to post-session features like 
reporting, archiving recordings and sending follow-up emails). See Add Co-Organizers for more 
information.  
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Give an attendee keyboard and mouse control 
When you are Presenter, you can grant other attendees shared control of your keyboard and mouse. This 
allows them to move the mouse about your shared screen and use their own keyboard to type on it, 
which can aid in collaboration. Of course, your mouse always has priority. You can always override 
another attendees' mouse movements to temporarily regain control without removing their access. See 
Give Keyboard and Mouse Control for more information.  

Stop/start attendee webcam sharing 
• To request that an attendee start sharing their webcam, right-click their name in the Attendee 

list and select Send Webcam Request. The attendee will be prompted to share their webcam 
(they can click Share My Webcam or Not Right Now).  
Note: This feature is only available for staff members (Presenters, panelists and organizers).  

 

• To stop sharing an attendee's webcam, right click their name in the Attendee list and select 
Stop Webcam Sharing. 

 

Show/Hide Attendees pane for an attendee 
If desired, you can allow attendees to see the Attendee list in their Control Panels. 

• To do so, right-click their name in the Attendee pane and select Allow Attendee List. A 
Checkmark icon  will be displayed next to the selection when it is enabled, and will disappear 
when it is disabled.  

© 2015 Citrix Systems. All rights reserved. 136 



GoToWebinar User Guide 

 

Dismiss an attendee 
You can remove an attendee from the meeting by dismissing them. To do so, right-click their name in the 
Attendee list, select Dismiss Attendee, and then click Yes to confirm. Attendees will automatically be 
disconnected from the session and will see a message notifying them that they were dismissed from the 
meeting.  
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Add Co-Organizers 
As the scheduling organizer of a session, you can allow other attendees to be co-organizers who can 
facilitate the session with you. You can either add an organizer before a session begins (which allows 
them to start the session on your behalf), or you can promote an attendee to organizer while in session. 
Co-organizers are able to access all the same session features as the scheduling organizer (however, co-
organizers who are promoted during a session will not have access to post-session features like 
reporting, archiving recordings and sending follow-up emails).  

Add a co-organizer before the session 

You can make someone a co-organizer before the session begins so that they can start the session if you 
are unable to. 

1. Log in to your online account.  

2. Either schedule a new or open an existing webinar.  

3. On the Manage Webinar page, click Edit next to Co-organizers. Then click Add Organizer. 

4. Enter the name and email address of the desired individual, then click Add another organizer to 
add additional people if needed. GoToWebinar will remember their info and suggest it to you the next 
time you add co-organizers to a webinar. 

Note: If  there are other organizers on your same GoToWebinar account, then you w ill see their names appear in a drop-dow n 
menu w hen you start typing the name. You can select the check boxes next to the desired individuals to have their name and 
email automatically added.  
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5. Click Save when finished. 

 

© 2015 Citrix Systems. All rights reserved. 139 



GoToWebinar User Guide 

Promote an organizer during a session 
1. In the Attendees pane, right-click the name of the desired attendee and select Make Organizer. 

 

2. You will be prompted to confirm that you wish to promote the attendee to organizers. Click Yes to 
continue. The attendee will be notified of their new organizer status. 

 

Add Panelists 
 Panelists are members of webinar staff who can speak, present, share webcams and answer assigned 
questions during a session. You can either add panelists before a session starts, or promote attendees to 
panelists during the session.Unlike co-organizers, panelists cannot start or facilitate a session on their 
own.  

Add a panelist before a session starts 
1. Log in to your online account.  

2. Either schedule a new or open an existing session.  

3. On the Manage Webinar page, select Edit next to Panelists. 

4. Enter the person's name and email address.  
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5. To add another panelist, click Add Another Panelist. 

6. When you're done, click Save. You can view your panelists on the Manage Webinar page. Your 
panelists will receive an invitation email with a link to join the session. 
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Add a panelist in-session 
1. Right-click an attendee's name in the Attendee List and select Make Panelist.  

 

2. When you're prompted to make them a panelist, click Yes.  

3. If you want a panelist to show their screen, you can make them a presenter.  
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Dashboard 
The Dashboard allows you to monitor the session at-a-glance. You can quickly view the timer (duration of 
the session), attendance, audience attentiveness, questions and raised hands. 

Monitor the Dashboard 
• Timer: Begins when the presenter starts sharing their screen. The duration of the session is based 

on the scheduled start and end times. 
• Attendance: Shows the number of session participants in-session. 
• Attentive: Displays the percentage of session participants who have the GoToWebinar Viewer on 

top of all other applications in comparison to those who have the GoToWebinar Viewer in the 
background. 

• Questions: Shows the number of attendee questions waiting for a response. Clicking the number 
opens the Questions pane where you can read and respond to open questions. 

• Polls Given: Displays the number of Polls that already have been launched and closed over the 
total number of Polls waiting to get launched for the session.  

• Hands Raised: Shows the number and percentage of session participants who've raised their 
hands. Clicking the number opens the Attendee List where you can see who has raised their hand. 
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Audience View 
The Audience View displays a thumbnail view of what attendees see when you share your screen. You 
can literally see what your attendees are seeing by looking at the Audience View pane. 

Note: Audience view  is not currently available for Mac users. 

View what your audience see 
• Audience View: Allows presenters to view a thumbnail image of what everyone else in the session 

is seeing. 
• Attentive: Displays the percentage of participants who have the GoToWebinar Viewer on top of all 

other applications in comparison to those who have the GoToWebinar Viewer in the background. 
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Polls 
You can use Polls to engage your attendees and focus their attention on the session. You can create 
Polls before the session starts or during the session on-the-fly. After you close a Poll, you can choose to 
show the results to your attendees immediately or later. Shared results display total attendee responses 
and don't include any individual information. You can view attendees' responses after the session by 
creating an Attendee Report. 

Launch and close a Poll 

1. In the Polls pane, scroll to the Poll you want to launch. Click the Launch button so that attendees 
see the Poll in their Viewer. 

2. After you've given attendees time to respond, click the Close button to close the Poll. 

Show Poll results 
1. In the Polls pane, find the Poll you want to share with your attendees. 

2. Click the Share button. 

3. To resume presenting, click Hide. 
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Create or edit Polls in-session 
1. Expand the Polls pane in your Control Panel. If you're presenting, first pause or stop Screen 
Sharing. 

2. Click Manage Polls. Log in to your account if prompted – you'll be taken to the Manage Polls page 
where you can create new Polls.  

 

3. After editing your Poll, click Save. You may need to log out of your account to see the new or 
updated Polls in the Polls pane. 

4. Return to the session, and select a Poll from the drop-down menu. Click Launch. Screen Sharing 
will be temporarily paused while the Poll is in-progress.  

 

5. Click Close when everyone has voted. To show the results to everyone, click Share. Then click 
Hide to resume the webinar.  
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Question and Answer 
Before a session begins, you can create Questions to engage your attendees in-session. Attendees can 
ask Questions to organizers during a session. You can sort the Questions and flag them with priority. You 
can also assign Questions to another organizer or panelist. Only organizers can view all Questions and 
Answers, set priority and assign Questions to other organizers or panelists. Panelists can only see 
Questions assigned to them.  

Answer your attendees' Questions 
1. In the Questions pane on the Control Panel, select the Question you'd like to answer. 

2. Type your response in the text field, or use the drop-down menu to respond, and click Send 
Privately to send the answer to the attendee only or Send to All to send the answer to everyone in 
the session. 

 

3. After you've answered a question, a checkmark will appear in the flag column. 
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Assign an attendee's Question to another organizer or panelist 
1. In the Questions pane on the Control Panel, select the Question to highlight the entire row. 

2. Right-click the actual Question, and select Assign Question to in the drop-down menu. 

3. Choose the name of the organizer or panelist. Whoever you choose will get assigned to the 
Question. 

 

Enable or disable Question and Answer 
1. On the top of the Control Panel, click Options.  

2. Select Attendees Can Ask Questions. If the option is checked, attendees can ask Questions. If 
the option is unchecked, Q & A is disabled, and no one can ask Questions.  
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Try Labs Features 
Citrix offers several beta features known as Labs, which are exciting new ways to enhance your sessions. 
Keep in mind that when you use a Labs feature, you are agreeing to use a feature that has not been fully 
tested and may still have some bugs. If you decide you no longer want to use a lab feature, you can 
always disable the feature from your Control Panel. 

Available Labs features 
The following Labs features are available to organizers: 

• Share a whiteboard 
• Show profile pictures for staff 
• Allow "sharing a rectangle" (screen sharing) 
• Show Control Panel to attendees 
• Use Webinar Analytics 

Enable/disable Labs features in desktop app 
Note: This is available to Window s users only.  

If you end a session with one or more Labs features enabled, then GoToWebinar will remember your 
preference when you next start or join a session. 

• To enable a Labs feature, select File > Labs. Then select the desired feature; once enabled, it 
will display a Check icon . 

• To disable a Labs feature, select it again in the Labs menu. Once the feature is disabled, the 
Check icon will disappear.  

 
Note: The f irst time you enable a Labs feature, you w ill be prompted to accept the terms of use. Click Agree to continue. 
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Note: This is available to Window s users only.  

Share a whiteboard 
Note: This is available to Window s users only. Sightboard must be enabled via the w eb app rather than the desktop app.  

Sightboard uses your HD webcam (and a little magic!) to broadcast an image of your whiteboard to 
attendees and share your updates in real time, allowing them to collaborate as if they were standing right 
in front of it. Sightboard can even see behind you as you write on the board and will automatically save 
snap shots documenting each change you make. See Share a Whiteboard for more information.  

Note: This is available to Window s users only.  

Show profile pictures for staff 
Note: This is available to Window s users only.  

This feature allows staff (i.e., panelists, presenters and organizers) to add profile pictures to their names 
in the Attendees pane. To enable/disable this feature, select File > Labs > Profile Pictures. 

• To add their profile pictures, Windows and Mac staff can drag and drop an image file into the 
Attendees pane. GoToWebinar will remember profile pictures for future sessions that have this 
feature enabled. 

• To remove their pictures, they can right-click their name and select Clear My Profile Picture. 

Staff can hover their mouse over another staff member's picture to see an enlarged version of the image.  
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Attendees will also see each staff member's picture appear next to their name in their Control Panel and 
Viewer (e.g., "Talking", "Now Viewing <attendee>'s Screen" messages). 

 

Allow "sharing a rectangle" (screen sharing) 
Note: This feature is available to Presenters as w ell as organizers. 

Note: This is available to Window s users only.  

This feature allows you to use select a specific portion of your screen (denoted by a framed area) to 
share with attendees.  

1. To enable this feature, select File > Labs > Allow Sharing a Rectangle. 

2. In the Screen Sharing pane, two new options will appear in the "Show My" drop-down menu: : 
"Rectangle" and "Rectangle - but hide my icons & taskbar".  

3. When you select one of the new options, a floating GoToWebinar rectangle will appear on your 
screen. You can click and drag the edges of the rectangle to change its size and shape as desired, 
then drag it around the screen to frame the area you want to share. Only the area within the frame will 
be shown to attendees. 
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4. The attendee's Viewer will automatically re-size itself to match the shape of the frame on your 
screen.  

 

Show Control Panel to attendees 
Note: This feature is available to Presenters as w ell as organizers. 

Note: This is available to Window s users only.  

By default, your Control Panel is hidden from attendees when you are sharing your screen. If desired, you 
can use this feature to have your Control Panel be visible on the shared screen.  

To enable/disable this feature, select File > Labs > Show my Control Panel to attendees during 
screen sharing. 
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Use Webinar Analytics 
Webinar analytics are a type of report available to organizers when logged in at 
https://global.gotowebinar.com. You can see analytics for all of your webinars by clicking View 
broadcasting data on the Webinar History page. You can also view analytics for a specific webinar by 
selecting the Webinar analytics report on the Generate Reports page. 
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Send Chat Messages 
Staff members (e.g., Presenters, panelists and organizers) can exchange instant chat messages with 
each other during a webinar. They can also send public chat messages to all attendees, which will appear 
in each attendee's Questions pane. 

If desired, staff members can save a Chat log after the session ends to review messages later.  

Chat with others 
Note: It is not possible for attendees to exchange chat messages w ith other attendees, but they can send questions to staff 
members if  desired. 

1. In the Chat pane, use the drop-down menu to select the recipient of the message:  

• All - Entire Audience – All participants will see the message; it will appear in the Chat pane for 
staff members and the Questions pane for attendees. 

• Organizers and Panelists only – All organizers and panelists will see the message in their Chat 
pane. 

• Presenter only – The Presenter will see the message in their Chat pane.  
• Individual staff member – Send a message to an individual Presenter or Panelist. 
• Send question to staff – All members of staff will see the message appear as a question in the 

Questions pane rather than their Chat pane.  

2. Type your message in the text field, then click Send.  

 

Save the chat log 
You can save a log of the Chat messages as a Rich Text file (.RTF). The Chat log will only include 
messages that you saw; any private message sent between other attendees will not be included. 

Note: This feature is only available for staff members (Presenters, panelists and organizers).  

1. Click File in the top navigation and select Save Chat Log. 

2. Select a location on your computer, and change the default name (if desired). 

3. Click Save. 
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Use Drawing Tools 
Participants can use drawing tools to draw directly on the shared screen so that the marks are visible to 
all attendees. This allows participants to highlight areas of the screen, draw attention to certain parts and 
generally illustrate their point. Organizers and presenters can allow only other organizers or all attendees 
to draw on the shared screen.  
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Use drawing tools 

1. Click the Drawing Tools button  in the Grab Tab.  

2. Use the menu to select the desired drawing tool (pen , highlighter , spotlight  or arrow ). You 
can also change the pen color, if desired.  

3. Click and drag the mouse over your desktop to start drawing on the shared screen. 

 

Enable/disable drawing tools for an individual 
1. Right-click the participant's name in the Attendee pane.  

2. Click Allow Drawing.  

• When drawing tools are enabled for the user, a Check icon  will appear next to Allow Drawing. 
The attendee can click and drag the mouse over the Viewer to make their drawings appear on 
the shared screen for all participants.  

• When drawing tools are disabled for the user, the Check icon  will disappear.  
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Erase all drawings 

1. Click the Drawing Tools button  in the Grab Tab.  

2. Select Erase all drawings. All drawings done by any participant will immediately disappear. 
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Desktop Notifications (Windows) 
Desktop Notifications is a free GoToWebinar feature for Windows users designed to deliver simple and 
effortless access to complimentary Citrix software upgrades, information, news and discounts you may be 
eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive 
important product information that is relevant to you. Desktop Notifications are sent only by Citrix as a 
service to our customers. 

Show desktop notifications 

Occasionally, when you are connected to the Internet, Desktop Notifications will automatically connect 
with Citrix servers to see if there are any new messages for you. If there are any messages for you, 
Desktop Notifications will display them on your computer screen. 

 

Disable desktop notifications 
1. To disable desktop notifications, unselect the "Show me desktop notifications" check box the next 
time a notification appears.  

2. You should no longer receive notifications on your desktop.  
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Dismiss Attendees 
You can remove an attendee from the meeting by dismissing them. To do so, right-click their name in the 
Attendee list, select Dismiss Attendee, and then click Yes to confirm. Attendees will automatically be 
disconnected from the session and will see a message notifying them that they were dismissed from the 
meeting.  
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Leave and End a Session 
You can leave or end a session anytime during the session (regardless of the scheduled end time). 
Organizers will be given the option to leave a session without ending it for everyone else so that others 
can continue without them. 

 

Leave a session (without ending it) 
1. Click File in the top navigation and select Exit - Leave Webinar. 

2. Continue as follows: 

• If there are already 1 or more co-organizers in the session, you can click Yes to confirm that you 
want to leave. The session will continue without you, and the other organizer(s) can take over 
facilitating.  

 

• If there are not any co-organizers in the session, you can click Choose and Organizer & Leave, 
select an attendee from the drop-down menu and click Yes to confirm that you wish to make 
them an organizer. You will then exit the meeting.  
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End a session for everyone 
1. Click File in the top navigation and select Exit - End Webinar. 

2. If prompted, click End Webinar for All.  

3. Click Yes to confirm that you want to end the session for everyone.  

 

In-Session FAQs 
Review frequently asked in-session questions. 

How can I view what my attendees see during a session? 
When you're presenting on a Windows computer, the Audience View in your Control Panel shows you a 
thumbnail view of what your attendees see. 

How can I make an attendee the presenter so that they can share their screen? 
During the session, you can right-click an attendee's name in the Attendee List, and select Make 
Presenter. The attendee now becomes a panelist for the remainder of the session and can share their 
screen. 

How can panelists view Q & A? 
If you promote a panelist to an organizer role, they can view and manage Q & A from the Control Panel. 
The panelist now becomes an organizer for the remainder of the session and has full control of the 
session like you. 

How can my co-organizer launch a Poll for me so that I can participate in the 
polling? 
Whoever launches the Poll can see the Poll in their own Control Panel and in the attendees' Viewers. If 
you're presenting, another organizer can launch a Poll so that you can view and respond to the Poll from 
your Control Panel. 
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Audio 
Connect to Session Audio 
Depending on the options provided by the session organizer, attendees can connect to session audio 
using various methods. Participants can also test their audio connection before or after a session if 
needed. 

Note: Organizers can see Manage In-Session Audio for information about changing audio modes during a session and 
enabling/disabling chimes and on-hold beeps.  

Available audio modes 

Organizers can either select one or more of the built-in audio options, or they can provide their own 
conference call info.  

Built-in audio conferencing 

• Computer audio (VoIP): Participants can connect to audio through their computer's internet 
connection using a mic and speakers. 

• Conference call: Participants can use a telephone to dial in to the session audio using toll and/or 
toll-free phone numbers (depending on the organizer's settings). 

Third-party audio conferencing 

• Custom conference call info: Participants can use a telephone to dial into the session audio 
using a third-party audio service (provided by the organizer).  

Connect via computer audio (VoIP) 

Audio quality may vary depending on the audio software, hardware, operating system and Internet 
connection being used. We recommend using a USB headset plugged directly into the computer and 
placing the microphone away from other speakers or devices to avoid noise feedback. 

Note: This feature is only available if  enabled by the organizer.  

1. First ensure that your mic and speakers are properly plugged in to your computer. 

2. In the Audio pane, select Mic & Speakers. You can use the drop-down menus to select the right 
audio hardware. 
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Connect via telephone 
Note: This feature is only available if  enabled by the organizer.  

1. First locate the audio information provided by the organizer. You can find it in any of the following 
locations: 

• Check the Confirmation email that was sent after registering for the webinar.  

  

• While in session, go to the Audio pane and select the Telephone option. 

 

2. Find the phone number for the desired country. 

• Check the list of phone numbers included in the Confirmation email (listed by country). 
• During the session, click additional numbers in the Audio pane to see a list of all countries and 

their phone numbers.  

 

3. Use a telephone to dial the provided phone number.  

4. When prompted, enter the Access Code and Audio PIN listed in the session information. See 
Manage audio via keypad commands (phone mode only) for more information. 

Note: If  you are having trouble w ith your audio connection, you can check for alternative phone numbers.  
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Connect via custom conference call 

If the organizer uses a third-party conference-call service, they may wish to provide their own details 
about how to connect to the session audio. In this case, their instructions will appear in the Hallway and 
on the Audio tab (Options page). 

Note: This feature is only available if  enabled by the organizer.  

 

Switch between audio modes 
Attendees can switch between the provided audio modes any time during the session by opening the 
Audio tab (Options pane) and selecting the desired audio mode.  

Note: Only those options provided by the organizer w ill appear. If  only one method of connecting w as provided, then attendees will 
not be able to sw itch to another audio mode. 

 

Manage audio via keypad commands (phone mode only) 
 

When participants are connected via telephone, they can use their phone's 
keypad to manage the audio of the conference call.  

All participants: 

• *3 – Turn "on-hold" beeps on or off 
• *4 – Hear a menu of keypad commands available to you.  
• *6 – Mute or unmute the participants audio. 
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Organizers only: 

• *2 – Hear the number of attendees currently dialed in via telephone. 
• *5 – Change the "listening mode" of all attendees; pressing this command repeatedly will cycle 

through the following modes: 
• Soft mute: All attendees are automatically muted, but they can unmute themselves if 

desired. 
• Hard mute: All attendees are automatically muted and cannot unmute themselves. 
• Unmute: All attendees are automatically unmuted (default mode). 

• *8 – Change the "chime controls"; pressing this command repeatedly will cycle through the 
following modes:  

• Both entry and exit chimes on (default) 
• Both entry and exit chimes off 
• Only exit chimes on 
• Only entry chimes on 

Check for alternative phone numbers 

If you are having trouble connecting to the session with the phone number provided in the Options pane, 
you can check to see if the organizer provided any alternative phone numbers. 

1. On the Audio tab (Options pane), click Problem dialing in?. 

2. A new browser window will open and direct you to the right page. 

3. Use the drop-down menu to select the desired country, then use the alternative session information 
provided to try dialing in again. If you're still having problems connecting, see Audio Help for more 
information. 
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Manage In-Session Audio 
Once in session and connected to audio, the organizer can manage the session audio options for all 
participants. 

Note: This feature is available to organizers and co-organizers only. 

 

Enable/disable on-hold beeps 
When enabled, this feature plays intermittent beeps to indicate that no one has yet joined the session.  

1. On the Audio tab (Options pane), click the Options icon .  

2. In the pop-up menu, click the On/Off button next to Play On-Hold Beeps to immediately enable or 
disable them.  

Enable/disable entry and exit chimes 
When enabled, this feature makes a "chime" sounds that announces each time attendee joins or leaves 
the session. 

1. On the Audio tab (Options pane), click the Options icon .  

2. In the pop-up menu, click the On/Off button next to Play Entry/Exit Chimes to immediately enable 
or disable them.  
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Edit the audio mode while in session 
You can change the audio-connection methods available to attendees at any time, even while in session. 

1. On the Audio tab (Options pane), click the Options icon .  

2. In the pop-up menu, click Edit audio mode. 

3. In the Edit Audio Mode window, select the desired audio option. You will be cautioned that changing 
the audio during the session will immediately impact all customers and that you should warn them 
verbally before doing so.  

4. Click OK when finished.  
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Set Default Audio Options 
When you schedule a webinar, the audio options are set to the default settings for your account. You can 
change these default audio options at any time, which will affect all webinars that you schedule in the 
future.  

Note: Changing your settings w ill only impact w ebinars that you schedule after that point. It w ill not affect previously scheduled 
sessions; you must change those manually if  desired.  

Use built-in audio services 

GoToWebinar offers various built-in methods for participants to connect to the webinar audio. You can 
offer some or all of these methods to participants by changing your default audio options. 

Mic & Speakers (VoIP) Telephone (PSTN) 
Participants can use the mic and speakers 
on their computer to connect to the audio 
through the desktop, web or mobile app. 
This allows participants to join the audio 

without needing to use the telephone. 

Participants can use a telephone to dial in to the audio 
separately from the desktop, web or mobile apps. This allows 
participants to join the webinar even if they aren't able to the 

screen-sharing session. 

VoIP: This method allows participants to 
connect to audio over the internet using 

the desktop, web or mobile app with which 
they joined the session. 

Long-Distance (Toll): This 
method allows participants to dial 
in using long-distance (toll) phone 

numbers provided by 
GoToWebinar. 

Toll-Free: This method 
allows participants to dial in 

using toll-free phone 
numbers provided by 
OpenVoice Integrated.  

This method is free for both organizers 
and attendees. 

Each attendee will be charged 
rates based on their own long-

distance provider. 

Organizer's accounts will be 
charged a per-minute fee for 

each attendee who uses 
these methods. 
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Use your own audio service 
If you choose to provide your own conference call service, you must provide your own telephone numbers 
for participants, and you won't have access to built-in audio conferencing (VoIP, long distance and toll-
free numbers). 

• If you select Use my own conference call service under Settings, you can provide custom 
information telling attendees how to connect to the webinar audio using your third-party audio 
service. There will be separate fields for attendees, organizers and panelists. 
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Change default audio options 
1. Log in to your online account.  

2. Click Settings in the left navigation.  

3. Select the desired audio options, as follows: 

• Select Use built-in audio, then enable the check boxes of the methods that you would like to 
provide to customers: VoIP, long-distance (toll) numbers or toll-free numbers (OpenVoice 
Integrated). If desired you can change the countries for which phone numbers are provided. 

• Select Use my own conference call service, then enter the conference-call information of your 
third-party audio service. 

4. Click Save when finished. 
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Change the countries for which phone numbers are provided 
If you are providing long-distance (toll) or toll-free phone numbers for your customers, you can always 
choose which countries are included in the session information for each webinar. 

1. While changing the default audio options, click Edit next to the "Long distance number" and/or 
"Toll-free number" options. 

2. Select the desired countries. To select all countries available, select the check box next to "Country" 
at the top of the list. If desired, you can also designate a preferred country. 

3. Click Done when finished. When you return to the Settings page, you'll see the additional countries 
you added next to the long distance and/or toll-free option(s). 
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Broadcast Computer Audio 
While GoToMeeting is designed to efficiently broadcast voice audio over telephone or VoIP, there may be 
times when you wish to broadcast an audio recording from your computer. In this section you will find 
audio configuration instructions that should allow you to transmit both your voice and audio from your 
computer. Due to some sound card limitations, these procedures may not work with every system. 

Configure Windows XP to broadcast audio 
Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What 
U Hear" on some Soundblaster cards) or may be absent entirely. 

Note: You cannot use your microphone w hen switching via software. 

1. Double-click the volume icon in the system tray (usually bottom-right of your desktop). 

2. Select Options, then Properties. 

3. Under Adjust Volume, choose Recording. 

4. Ensure "Stereo Mix" is checked. 

5. Click OK. 

6. On the Recording Control screen, select the check box under Stereo Mix. 

Configure Vista or Windows 7 to broadcast audio 
Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What 
U Hear" on some Soundblaster cards) or it may be absent entirely. 

Note: You cannot use your microphone w hen switching via software. 

1. Right-click the volume icon in the system tray (usually bottom-right of your desktop). 

2. Select Recording devices from the menu. 

3. Right-click the first item on the list and ensure Show Disabled Devices is checked. 

4. Ensure Stereo Mix is the default device. 

5. Press OK. 
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Hardware option 
Parts needed: 

• Two (2) 3.5 mm audio splitters (1 male, 2 female). 
• One (1) 3.5 mm audio patch cable (2 male ends, typically 3 " long). 

Configure your system to broadcast with hardware 
1. Plug 1 splitter into your line out port (for speakers, typically colored green) 

2. Plug the other splitter into your microphone port (typically pink) 

3. Plug the patch gable into the splitter on line out and then into the splitter on microphone. 

4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out 
splitter. 

Note: You may use your microphone and speakers simultaneously.  
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Audio Conferencing FAQs 
Review frequently asked audio conferencing questions. 

Is there a cost for using the integrated audio conferencing feature? 
Your plan includes unlimited audio at no extra cost. You can use toll-based phone conferencing or VoIP 
(requires microphone and speakers) exclusively or allow participants to choose between both options. 
You can also provide your own conference call number for organizers, panelists and/or attendees, but 
you won't be able to choose our integrated audio conferencing options if you do so. 

 If you purchased a plan that provides toll (long distance) numbers, participants who dial in are charged 
their standard long-distance rate for calling. If you purchase Integrated Toll-Free service, your participants 
can dial in using a toll-free number, and you'll be charged according to the plan that you select. 

You and your attendees can also connect to the audio conference free of charge by choosing the Mic & 
Speakers (VoIP) option where you can send and receive audio over the Internet at no cost using a 
microphone and speakers connected to your computer. (A USB headset is recommended.) 

Is there a toll-free audio option? How do I sign up? 
If you'd like to purchase Integrated Toll-Free audio service provided by Citrix Online Audio so that your 
participants can dial in by telephone using toll-free numbers, call us at 1 866 962 6492. You can then 
provide your participants with a toll-free number if you so choose. Over 45 countries are available for toll-
free numbers. 

With this service, you can give your attendees the option of dialing in using VoIP, toll (long distance) or 
toll-free audio conferencing without any additional equipment needed.  

Can I mute/unmute all attendees at once? 
You can mute all attendees at once, but you can't unmute them all at once. You can also individually 
mute and unmute up to 25 attendees. 

Can I mute/unmute individual attendees? 

As the organizer, you can easily mute attendees on VoIP by clicking the Microphone icon  or 
Telephone icon  next to their name in the Attendee List. You can mute attendees who dial in by phone 
only if they entered their Audio PIN. Attendees will be able to unmute themselves if they wish to speak. 

Can I use my own toll-free phone numbers for all of my sessions? 
Yes. As an organizer, you can easily change your default audio options from the Settings page. Simply 
log in to your account, and select Settings to adjust the audio options for future sessions. To provide your 
, select Use my own conference call service on the Settings page, and enter the conference call info 
for attendees (and optionally for organizers and panelists). Then click Save to apply the audio settings for 
all future sessions (new default setting). 
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What microphone/speaker configuration is recommended for best audio quality 
using VoIP? 
For optimum audio quality, we recommend a USB headset connected to your computer, or USB 
headphones and standalone microphone connected to your computer. Analog versions are okay, but not 
ideal. We don't recommend using a webcam mic. 

Can I test the quality of my microphone and speakers setup before a session? 

Yes. Just right-click the GoToWebinar daisy icon  in your system tray, and select Preferences > 
Audio to choose the device(s) you want to test. 

Where can I go for help with audio problems? 
Please see our Audio Help for tips on how to troubleshoot common audio problems 

Can I broadcast my computer's audio?  
Although GoToWebinar is designed to broadcast audio over VoIP or telephone, you can also broadcast 
recorded audio from your computer. Due to some sound card limitations, these instructions may not 
always work on every system. 

Broadcast audio on Windows 7 or Vista  

1. Right-click the Speakers icon  in the system tray, and select Recording devices.  

2. On the Recordings tab, right-click the first item on the list, and select the Show Disabled Devices 
option. 

3. Check that Stereo Mix is the default device, and click OK. 

Broadcast audio on Windows XP 

1. Double-click the volume icon in the system tray. 

2. Select Options > Properties. 

3. Below Adjust Volume for, choose Recording. 

4. Check that Stereo Mix is enabled, and click OK.  

5. On the Recording Control window, select the check box under Stereo Mix. 

Broadcast audio using hardware 

You will need the following: 

•  Two 3.5 mm audio splitters (one male, two female) 
• One 3.5 mm audio patch cable (two male ends, typically 3" long) 

1. Plug one splitter into your line out port (typically green for speakers). 

2. Plug the other splitter into your microphone port (typically pink). 

3. Plug the patch cable into the splitter on line out and then into the splitter on your microphone. 

4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out 
splitter. 
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OpenVoice Integrated (Toll-Free Audio) 
Organizers whose accounts include an OpenVoice Integrated subscription can use it to offer their 
attendees toll-free phone numbers for over 50 countries. This provides attendees with an alternative to 
connecting with their mic and speakers (VoIP) or incurring long-distance phone charges, making it easy 
for them to choose the most convenient method of joining the audio conference.  

Note: OpenVoice Integrated toll-free audio service must be purchased separately from your GoToWebinar plan. Organizers incur 
per-minute changes for each attendee w ho uses the OpenVoice integrated toll-free audio service. If  you have a GoToMeeting 
corporate plan and your billing address is based in the U.S., U.K., Canada or Australia, you may purchase OpenVoice integrated 
toll-free audio online.  

Note: This article refers to OpenVoice Integrated, w hich allows you to add toll-free phone numbers to your w ebinars. How ever, 
OpenVoice is also offered as a standalone audio-conferencing product.  

Create a new account that includes OpenVoice Integrated 
1. Start the sign up process for GoToWebinarhere. 

2. During Step #2, enable the "Add toll-free numbers provided by Citrix OpenVoice" check box. 

 

© 2015 Citrix Systems. All rights reserved. 177 

http://www.gotomeeting.com/online/toll-free
http://www.gotomeeting.com/online/toll-free
http://www.gotomeeting.com/online/webinar


GoToWebinar User Guide 

Add OpenVoice Integrated to your GoToWebinar plan 
You can add OpenVoice Integrated to your existing GoToMeeting account at any time. Once your 
account includes OpenVoice Integrated, you will see the toll-free audio option whenever you schedule 
webinars and under the default audio options. 

Note: If  you have a plan that is billed via invoice, then you must contact your Account Manager or Global Customer Support to 
modify your account and subscription plans. 

1. Log in to your online account.  

2. On the My Account page, click How It Works under "Add OpenVoice Toll-free Numbers to your 
GoToWebinar Plan".  

3. Click Subscribe Now to confirm. 
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Schedule a session with OpenVoice Integrated toll-free audio 
When you schedule a new webinar, you will automatically see the option to include toll-free numbers if 
you have a plan for OpenVoice Integrated. Simply select the option if desired, then click Edit to change 
the countries for which toll-free phone numbers will be provided. 

 

Available international countries with OpenVoice integrated toll-free audio 
See the available international toll-free and long-distance (toll) numbers. 
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Unsubscribe from OpenVoice 
You can cancel your subscription to OpenVoice integrated at any time. Keep in mind that you and other 
organizers on your account will lose access to toll-free numbers, and that toll-free numbers will be 
removed from all scheduled sessions associated with this account. 

Note: If  you have a plan that is billed via invoice, then you must contact your Account Manager or Global Customer Support to 
modify your account and subscription plans. 

1. Log in to your online account.  

2. On the My Account page, click Remove Toll-free Numbers under "Toll-free Numbers for 
GoToWebinar, Provided by OpenVoice".  

3. Click Unsubscribe Now to confirm. 

 

OpenVoice Integrated (Toll-Free Audio) FAQs 
Review frequently asked questions about OpenVoice Integrated (toll-free audio). 

What is OpenVoice Integrated (toll-free audio)? 
Organizers whose accounts include an OpenVoice Integrated subscription can use it to offer their 
attendees toll-free phone numbers for over 50 countries. This provides attendees with an alternative to 
connecting with their mic and speakers (VoIP) or incurring long-distance phone charges, making it easy 
for them to choose the most convenient method of joining the audio conference. See OpenVoice 
Integrated (Toll-Free Audio) for more information. 

How much does it cost to use OpenVoice Integrated? 
Per-minute charges are based on your service contract, and minutes are calculated per participants. For 
instance, if 3 participants dialing to the session for 10 minutes using the toll-free option, you will have 
used 30 minutes of your plan. Those who join by regular toll numbers are charged rates based on their 
own long-distance provider. There are no additional charges for those who join a session using VoIP. 

How am I billed for OpenVoice Integrated? 
You will receive a separate monthly invoice from Citrix Online Audio, LLC for any toll-free minutes used 
by you and your attendees. 
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How do I add the toll-free option to sessions that I've already scheduled? 
For any sessions that were scheduled prior to enabling toll-free integration, the regular toll-based 
conference numbers will automatically be changed when toll-free numbers are added to an existing 
session. It is recommended that you resend the invitation email to participants so they have access to the 
new toll-free audio information. The Webinar ID and URLs will stay the same, and the new toll-free 
number will be provided to attendees in the Waiting Room, as well as in the Audio Pane of the Control 
Panel. 

How do I schedule a session with OpenVoice integrated toll-free? 
When you're scheduling a session, click Edit countries in the Audio section to choose which toll-free 
numbers you'd like to provide to attendees. 

For which countries do you offer international toll-free & long-distance (toll) 
service? 
See the available international toll-free and long-distance (toll) numbers. 

Is there anything different about recording a session with OpenVoice integrated 
toll-free? 
No. Whether you or your attendees join with VoIP, long distance or toll-free audio, you can seamlessly 
record audio. Open Preferences > Recording > Use GoToMeeting integrated audio. 

How can I cancel OpenVoice integrated toll-free? 
If you'd like to cancel your OpenVoice integrated toll-free service, please contact our 24/7 Global 
Customer Support. 

Audio Help 
If you are experiencing difficulty with audio, determine which scenario is applicable to you and follow the 
recommended guidelines. 

I can't hear anyone 
Test your audio setup by clicking Settings in the Audio pane of your Control Panel. Or, you can right-click 

the GoToWebinar daisy icon  in your system tray, and select Preferences > Audio. Check to see if 
you're using an appropriate audio device. Click Play Sound to check that you can hear sound from your 
speakers. Speak into the microphone to test your microphone setup. 
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No one can hear me. 
If you're the organizer, you must click Start Broadcast at the top of your Control Panel, or press *1 on 
your telephone's keypad to start the audio conference. 

Check to see that you're not muted by clicking the Audio icon  in your Control Panel or Grab Tab.  

If you're experiencing problems dialing in by phone, try hanging up and dialing in again.  

If you're having problems connecting to VoIP (Mic & Speakers), test your computer's detected audio 
devices by clicking Settings in the Audio pane. Speak into your microphone to test if your microphone 
setup is working.  

I hear static or clicking sounds. 
Move electronic handheld devices, such as an iPhone, away from your mic and speakers. 

I hear echo, feedback or background noise. 
If you suspect that the echo is coming from an attendee, check to see who's talking at the bottom of the 

Audio pane in the Control Panel, and mute the attendee by clicking that person's Audio icon . 

If you dial in to the audio conference by telephone, make sure that you select Telephone from the Audio 
pane in the Control Panel instead of Use Mic & Speakers. 
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Built-in or external speakers may cause an echo. Try lowering the speaker's volume. 

Built-in microphones on your computer or webcam can pick up noise and cause an echo. We don't 
recommend using built-in microphones. Try plugging in a USB headset to your computer. 

The audio quality is poor and choppy. 
Poor network performance, lack of memory or high CPU usage often causes the audio quality to drop, 
become delayed or sound robotic. 

Try closing all applications you aren't using to free up some bandwidth. 

If you're using a dial-up Internet connection with VoIP, it may cause poor performance. For optimum 
performance when using VoIP, we recommend using a broadband Internet connection. 

 If the problem persists, switch to Telephone mode. Select Use Telephone in the Audio pane and dial in 
to the audio conference. 

No sound is detected. 
After the first minute of a session, GoToWebinar looks for microphone input from attendees who have the 
following: a microphone, speaking rights and unmuted. 

If no audio input is detected, you may see a "Trying to speak?" pink tip. You may see the error when you 
haven't spoken or made any sounds when the session starts or if your microphone device is incorrectly 
selected. Click Audio Setup in the Audio pane to test your input device. 

No microphone is detected. 
If a microphone (or headset) isn't detected or connected properly, you may see a pink tip.  

Check that your microphone (or headset) is properly plugged in. 

If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference 
using the telephone number and Audio PIN provided in the Audio pane of your Control Panel. 

My microphone is disconnected. 
If your microphone isn't working or gets unplugged during a session, you may see a pink tip.  

Check that your microphone is properly plugged in. 

If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference 
using the telephone number and Audio PIN provided in the Audio pane of your Control Panel. 
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I can't connect to audio with VoIP. 
In some cases, you will see an error that reads "Internet Audio Not Available." In this scenario, are a few 
things you can try to connect to the audio in the meeting. 

 

If you see the above error message, please try the following: 

•  Update the device drivers for your sound hardware. 
• Close any programs on your computer that you are not using. 
• Unplug audio hardware that you are not currently using. 
• Exit the GoToMeeting program and restart it.  

Note: If you see this error message in the Audio pane, you will not be able to record your session 
unless "No Audio" is selected in the Recording Preferences. Audio PINs and muting controls will also 
be disabled.  
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Reports and History 
Registration Report 
The Registration Report shows details about your registrants, including the registration date and time, as 
well as registrant data. Use Registrant Reports to track the registration process for an upcoming session. 

The Registration Report may include the following data (depending on any customizations you have in 
the registration form): 

Date Range Last Name Custom Questions 
Session Title Email Address Address 
Session Date Approval Status City 
Scheduled Start Time Phone State/Province 
Scheduled Duration Organization ZIP/Postal 
Registered Organization Job Title Country 
First Name Questions and Comments Industry 
Purchasing Time Frame Role in Purchase Process No. of Employees 

Generate a Registration Report from the Generate Reports page 
Log in to your online account.  

2. Select Generate Reports in the left navigation. 

3. Select the report type: 

• Registration Report – Shows when each person registered for the training and their answers to 
the registration questions. 

• Attendee Report – Shows details about each attendee, including registration information and how 
long they attended the session. 

• Performance Report – Shows high-level statistics on the session. 
• Survey Report – Shows a session’s Survey questions and attendee’s answers. 
• Recorded Webinar Report – Shows details about viewers and when the recording was 

downloaded. 

3. Choose a date range within the last year, or choose specific From and To dates to filter your report 
data. 

4. Click Show Webinars to see the results. 

5. To export the data, click Generate Excel Report. 
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Generate a Registration Report from the Registrants page 
Log in to your online account.  

2. Select My Webinars in the left navigation. 

3. Click the title of a session to go to the Manage Webinar page.  

4. In the Registrant Management section, click Manage. 

5. On the Registrants page, click Registration Report to export registration data to Excel. 
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Attendee Report 
The Attendee Report shows details about attendees, including registration, Q & A responses, in-session 
time and interest rating. Use Attendee Reports to follow up with interested attendees after a session. Any 
custom registration questions you added to the registration form will appear in the report. 

The Attendee Report may include the following data (depending on any customizations you've added): 

  

  

Date Range Attended Custom Questions 
Webinar ID Address Registration Date 
Webinar Title City Question and Answer 
Webinar Date State/Province Poll Question 
Actual Duration ZIP/Postal Interest Rating 
Total Attended Organization In-Session Time 
Name Job Title Duration In-Session 
Email Address Questions and Comments   
Country Phone   

Generate a Report 
Log in to your online account.  

2. Select Generate Reports in the left navigation. 

3. Select the report type: 

• Registration Report – Shows when each person registered for the training and their answers to 
the registration questions. 

• Attendee Report – Shows details about each attendee, including registration information and how 
long they attended the session. 

• Performance Report – Shows high-level statistics on the session. 
• Survey Report – Shows a session’s Survey questions and attendee’s answers. 
• Recorded Webinar Report – Shows details about viewers and when the recording was 

downloaded. 

3. Choose a date range within the last year, or choose specific From and To dates to filter your report 
data. 

4. Click Show Webinars to see the results. 

5. To export the data, click Generate Excel Report. 
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Performance Report 
The Performance Report shows high-level statistics on the session from start to finish, including data on 
the success of a session. 

The Performance Report may include the following data: 

Date Range Registered Number of Surveys 
Submitted 

Webinar ID Attendance Rate Survey Response Rate (%) 
Webinar Title Average Attentiveness Time 
Webinar Date Average Attendee  Number of Attendees 
Actual Duration Interest Rating Percentage of Total 

Attended (%) 
Total Attended Question and Answer Average Attendance 

Duration 
Polls Polls Response Rate (%) Response Rate 

Generate a Report 
Log in to your online account.  

2. Select Generate Reports in the left navigation. 

3. Select the report type: 

• Registration Report – Shows when each person registered for the training and their answers to 
the registration questions. 

• Attendee Report – Shows details about each attendee, including registration information and how 
long they attended the session. 

• Performance Report – Shows high-level statistics on the session. 
• Survey Report – Shows a session’s Survey questions and attendee’s answers. 
• Recorded Webinar Report – Shows details about viewers and when the recording was 

downloaded. 

3. Choose a date range within the last year, or choose specific From and To dates to filter your report 
data. 

4. Click Show Webinars to see the results. 

5. To export the data, click Generate Excel Report. 
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Survey Report 
The Survey Report shows the session's Survey questions and attendee's answers. Use the Survey 
Report to view your attendee's responses. 

The Survey Report may include the following data (depending on any customizations you've added): 

Report Generated Time Email Address  Last Name  
Webinar ID Submitted Date/Time  First Name  
Survey Name  Survey 

Questions/Responses 
  

Generate a Report 
Log in to your online account.  

2. Select Generate Reports in the left navigation. 

3. Select the report type: 

• Registration Report – Shows when each person registered for the training and their answers to 
the registration questions. 

• Attendee Report – Shows details about each attendee, including registration information and how 
long they attended the session. 

• Performance Report – Shows high-level statistics on the session. 
• Survey Report – Shows a session’s Survey questions and attendee’s answers. 
• Recorded Webinar Report – Shows details about viewers and when the recording was 

downloaded. 

3. Choose a date range within the last year, or choose specific From and To dates to filter your report 
data. 

4. Click Show Webinars to see the results. 

5. To export the data, click Generate Excel Report. 
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Recorded Webinar Report 
The Recorded Webinar Report shows details about your recording history, including who registered to 
view recordings and when recordings were viewed.If you choose to attach a recording in a follow-up 
email, the Recorded Webinar Report will also show which attendees viewed the recording from the follow-
up email. Use the Recorded Webinar Report to see past data on recording uploads, views, etc. 

Generate a Report 
Log in to your online account.  

2. Select Generate Reports in the left navigation. 

3. Select the report type: 

• Registration Report – Shows when each person registered for the training and their answers to 
the registration questions. 

• Attendee Report – Shows details about each attendee, including registration information and how 
long they attended the session. 

• Performance Report – Shows high-level statistics on the session. 
• Survey Report – Shows a session’s Survey questions and attendee’s answers. 
• Recorded Webinar Report – Shows details about viewers and when the recording was 

downloaded. 

3. Choose a date range within the last year, or choose specific From and To dates to filter your report 
data. 

4. Click Show Webinars to see the results. 

5. To export the data, click Generate Excel Report. 
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View Webinar History 
You can view webinar history to see information on your past sessions, including the session’s date, time, 
title, duration and attendees. If a session has just ended, it may take up to 15 minutes before it appears in 
your webinar history. Your webinar history is stored indefinitely (unless a webinar is canceled). 

View past webinar history 
Log in to your online account.  

2. Select Webinar History from the left navigation. 

3. On the Webinar History page, all past webinars are shown. 

View attendee details 
1. On the Webinar History page, select the number in the Attendees column to view attendee details 
(i.e., name, email address and join and leave times) for a past session. 

2. To export the attendee data to Excel (.XLS), click the Export to Excel button. 
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Session Recording 
Record a Session 
You can record any session and then store the recording for attendees to view at a later time. When a 
session is recorded, then the presenter's screen, the audio and any shared applications are recorded.  

Get started with session recording 
Successfully using session recording requires a series of steps on the part of the organizer. Use the steps 
below to set up and use session recording. 

1. Record sessions: You can start and stop recording during webinars. 

2. Convert recordings: After each recorded session, a temporary recording file is saved to the 
specified location in .G2M format. You must then convert the recording into a downloadable format 
(.MP4, .WMV or .MOV).  

3. Upload recordings: To allow attendees to access the newly converted recordings, you can upload 
them to the My Recordings page. 

4. Share recordings: You can obtain the direct URL to the uploaded recording and then share it with 
attendees.  

5. Play back recordings: Attendees can use the direct URL to view the recording on any device.  

Start and stop recording a session 
Note: We recommend having 2 organizers record the session in case 1 organizer encounters any issues that may potentially disrupt 
the recording. 

1. Ensure that you are sharing your screen, application and/or webcam if needed.  

2. To start recording a session, click the Start Recording button in the Screen Sharing pane of the 
Control Panel. If you do not see the button, click View > Recording in the Control Panel menu. 

 
Note: The free storage space available in the saved recording f ile location is displayed next to the button. At least 500MB of 
free space must be available to record a session in GoToMeeting format, and at least 1GB of free storage space for Windows 
Media Player and .MOV format. If  the recording space drops below  100MB, the recording automatically stops. 

3. The button will change to Stop Recording in your Control Panel. All attendees in the session will 
see a "This session is being recorded" notification at the bottom of their Control Panel.  
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4. To stop recording a session, click the Stop Recording button to temporarily pause or stop 
recording altogether. If you do not see the button, click View > Recording in the Control Panel menu.  

Note: The recording may take some time to process and convert, depending on w hich recording media format you chose. If you 
didn't choose a location to save your recording to before the session started, the recording f ile is located in the My Documents 
folder by default. 
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Convert Session Recordings 
Once a session has been recorded, the temporary recording file (.G2M) must be converted before 
anyone can view it. Using the Recording Manager, you can easily convert multiple recordings at once 
whenever it's convenient for you.  

Open the Recording Manager 
You can access the recording manager at any time in any of the following ways: 

• When you end a session, the Recording Manager will automatically launch and prompt you to 
convert your recordings. 

• Right-click the Daisy icon in the system tray, then select Convert Recordings (Windows only). 
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• Open Preferences > Recordings > Convert Recordings now.   
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Convert a recording 
1. Open the Recording Manager. 

2. Under "Recordings you need to convert", any unconverted files will be listed (both the most recent 
session and any past sessions that were not yet converted). Use the check boxes to select the files 
that you wish to convert. 

Note: If  you do not see the session recording you are looking for, simply locate it on your computer and move it to the specif ied 
Recordings folder. It w ill then automatically appear in the "Recordings you need to convert" section.  

3. Use the "Choose a file format" drop-down menu to select the desired format: 

• .MP4 (Windows only) Can be played on most Windows and mobile devices 
• .WMV (Windows and Mac): Can be played all Windows devices, as well as some Mac and 

mobile devices 
• .MOV (Mac only): Can be played on most Mac and mobile devices using Quicktime 

Note: If  you are converting a recording that w as made in 2012 or earlier, then you must use .WMV format (.MP4 w ill not w ork 
correctly).  

4. Click Convert Recording.  
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5. The conversion process will begin for the selected files. The recording may take some time to 
process and convert, depending on the video content and length, CPU speed, chosen media format 
and the amount of available memory.  
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6. Once the file has been successfully converted, it will be moved to the "Converted recordings" list in 
the Recording Manager. You can click the Folder icon  to automatically open the folder on your 
computer in which the converted file is stored.  

7. See Archive, Share and Manage Recordings for next steps.  
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Archive, Share and Manage Recordings 
After you've recorded a session and converted the recording, then you can store your recordings in the 
GoToWebinar web app and share the links with your attendees. You can also distribute a recording and 
send or upload the recording wherever else you'd like. 

Also see Recording and Playback FAQs for more information.  

Note: By default you have 3GB of storage space for your webinar recordings. You can upload a recording f ile no larger than 1GB at 
a time.  Although you can record sessions on Macs running OS X 10.6 (Snow  Leopard) or higher, you can only upload and stream 
.MOV files using Mac OS X 10.7 (Lion).  

Upload a session recording 
1. Ensure that the session recordings have been converted.  

2. Log in to your online account.  

3. Click My Recordings in the left navigation.  

4. On the My Recordings page, click Upload a recording > Select a file.  

 

5. Browse for and select the recording file from your computer. Recordings are saved to the location 
specified in the Recording Preferences (default is C:\Users\<username>\Documents). 

Note: Recording f iles must be .WMV, .MOV, or .MP4 format and less than 1 GB.  
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6. The recording will be processed and optimized to play back. You can choose to have an email sent 
to you once the recording is ready. 

You can use the My Recordings list to view the upload date, size, and recoding title, as well asshare 
or remove session recordings.  
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Share a direct link to the recording 
1. Log in to your online account.  

2. Upload the session recording and find it on the My Recordings list.  

3. Hover over the Share icon  next to the desired recording, then copy the URL provided in the pop-
up box. .  

4.Share the URL with registrants as desired (e.g., via email, instant message). 

 

Send new registrants archived recordings 
Archiving your event allows you to link an uploaded recording with a past webinar so that any attendees 
who register for the webinar after it has been held will automatically be sent to the archived session 
recording. This essentially turns the registration URL for the webinar into a link to the session recording. 

1. Log in to your online account.  

2. Go to My Recordings > Past Webinars tab.  

3. Click the name of the webinar you wish to archive.  

4. Click Edit next to Registration Settings. 

5. Click the Registration tab. 

6. Under "Recording", enable the "After the webinar ends, new registrants view a recording" check 
box. 

7. Click Select a Recording. 

8. Choose your recording and click Add  (upload a recording if needed). 

9. Click Save. 

10. Share the URL of your webinar with registrants as desired. 
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Attach a recording to a follow-up email 
1. First, upload the recorded session. You must wait until a session has ended before you will be able 
to convert the recording and see the session on the Past Webinars tab.  

2. Click My Webinars in the left navigation.  

3. Select a webinar to go to the Manage Webinars page. 

4. Under the "Share Your Webinar" > "Emails" section, click the Edit link next to either of the follow-up 
emails (attendees and/or absentees).  

 

5. Enable the "Send follow-up email to attendees" check box.  

6. Click the Select a Recording button, then select the desired recording. Remember, if you have not 
yet uploaded the video, then it will not be listed. Click Add when finished.  

See Share Webinars, Manage Registration and Send Emails for more information about modifying 
and sending follow-up emails.  

Note: If  you're an organizer on a corporate (i.e., "off line") account, only the organizer who originally added the recording to the 
follow -up email w ill be able to delete it. Co-organizers w on't be able to delete a recording that's been added by someone else, 
but co-organizers can still add a recording to a follow -up email if  one hasn't already been added. 
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Delete a session recording 
1. Log in to the GoToWebinar web app. 

2. Find the recording on the My Recordings page and click the Remove icon .  

3. Click Yes to permanently delete the recording. 

 

Locate Recording Files 
After each recorded session, a temporary recording file is saved to the specified location in .G2M format. 
You must then convert the recording into a downloadable format (.MP4, .WMV or .MOV).  

By default recordings are stored in C:\Users\<user>\Documents. The original "pre-converted" .G2M 
files are stored in a subfolder called "originals" after a successful conversion has finished. However, you 
can change the location for which all future session recordings will be saved (ensure it has at least 1GB 
of space available).  
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Change the location of saved files 
1. Right-click the daisy icon in the system tray and select Preferences.  

 

2. Go to the Recording tab.  

3. At the bottom of the window, click Browse.  

4. Select the desired location, then click OK.  
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Recording and Playback FAQs 
Here you can review frequently asked questions regarding session recording and playback. Please see 
Record a Session for details about starting and stopping session recording, as well as modifying the 
recording settings.  

How do I record a session? 

Please see Record a Session for details about starting and stopping session recording, as well as 
modifying the recording settings.  

How do I locate my session recordings? 
By default recordings are stored in C:\Users\<user>\Documents. The original "pre-converted" .G2M 
files are stored in a subfolder called "originals" after a successful conversion has finished. See Locate 
Recording Files for more information.  

 

How can I tell how much storage I have left? 
1. Log in to the GoToWebinar web app and click My Recordings in the left navigation.  

2. The Storage Space widget in the left navigation shows how much storage space is in use and how 
much is remaining. By default, you have 3GB of storage space for materials and recordings.  
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What file formats are supported? 
You can convert a session recording into any of the following formats: 

• .MP4 (Windows only) Can be played on most Windows and mobile devices 
• .WMV (Windows and Mac): Can be played all Windows devices, as well as some Mac and mobile 

devices 
• .MOV (Mac only): Can be played on most Mac and mobile devices using Quicktime 

Can people on Macs view sessions recorded on Windows computers (and vice 
versa)? 
Yes, as long as the session has been converted to .MP4 format. 

Can I include audio in my session recordings? 
Yes. The Recording Preferences will determine if and how audio is included in session recordings. The 
following options are available: 

• Don't record audio: Records the presenter's screen only. 
• Use GoToWebinar audio service: Records everyone who speaks via VoIP or telephone. 
• Use your own audio service: Uses a microphone to record the organizer's voice, while a phone 

patch device will record everyone else who speaks (requires a physical input device).  

Can I exclude audio from session recordings? 
Yes. You can modify the settings so that only the shared screen is included by selecting the "Don't record 
audio" option under Recording Preferences. 

 Can I record a session using my own audio service? 
Yes. If you're using your own conference call number, you must have a sound card and an audio input 
device like a microphone to record audio. If you're recording a teleconference, you can position the 
microphone next to the phone or set up a phone recording adapter to your phone and line-in input on your 
computer's sound card. If you're having trouble with your audio, see Audio Help. 

Can I edit a recorded session? 
Yes. You can use third-party editing software such as TechSmith Camtasia® to edit recording files. Just 
make sure that they have been converted first.  

Can I post a recorded session? 
Yes. You can upload your recorded sessions to the cloud so that your attendees can access them from 
any device.  

Can I mail a recorded session? 
Yes. After you've uploaded a recording to the My Recordings page, you can also attach the recording to 
follow-up emails by clicking Edit next to Follow-up Email on the Manage Webinar page. Then click Select 
a Recording under the email template to upload a recording to the follow-up email.  
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Mobile Apps 
Join Webinars via iOS 
You can download the GoToWebinar app for iOS to join webinars while on the go. Also see Use iOS 
Session Features to learn more about the features that are offered while in session.  

 

Join a session from the app 
1. Download the GoToWebinar app from the App Store.  

2. Open it and tap Join a Webinar.  

3. Find the correct session in either of the following ways: 

• Enter the webinar ID provided by the organizer, then tap Join.  

- or - 

• Tap the desired session under My Webinars (if you have the app connected to your calendar).  

4. You will be automatically launched into session. See   to learn about what you can do during a 
session.  
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Use iOS Session Features 
The GoToWebinar app for iOS allows you to view shared screens and webcams, as well as raise your 
hand to grab the presenter's attention.  

 

Ask a question 
• Tap the Question icon in the toolbar, then type your question and tap Send. 

 

Raise your hand 
• Tap the Raise Hand icon in the toolbar so that it turns blue. Tap it again to lower your hand.  

© 2015 Citrix Systems. All rights reserved. 214 



GoToWebinar User Guide 

 

View and rearrange panelist's shared webcams (iPad only) 
Tap the Webcam icon in the top navigation, then select one of the following views: 

 

• All – All webcams that are being shared will be displayed at the top of your screen. You can re-
size the webcams by clicking and dragging the re-sizeing bar. 

 

• Talking – Only the webcam of the panelists who are currently speaking will be shown at the 
bottom of your screen.  

 

• None – All shared webcams will be hidden. 

© 2015 Citrix Systems. All rights reserved. 215 



GoToWebinar User Guide 

GoToWebinar App for Android Permissions 
When you install the GoToWebinar app for Android on your device, the app will request permission to 
access different features on your Android device to run properly. While some of the permissions may 
sound scary, keep in mind that almost all apps require certain permissions to run features. Below is a 
table of the features that the app is requesting permission to, with an explanation of why the 
GoToWebinar app is requesting permission for this specific feature.  
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Feature How GoToWebinar Uses this Information 

Phone calls 

Directly call cell phone 
numbers, read phone status 
and identity 

The app will use your device's Phone app to dial in to the phone call (should you 
choose to do so) by tapping the switch to phone button in the app's audio tab. 
The app also reads the state of phone calls to mute or disconnect from the 
session audio so that the meeting audio does not interrupt your phone call.  

Bluetooth 

Pairs w ith Bluetooth devices 

The app will pair with your Bluetooth device to connect to your audio via 
Bluetooth. 

Network 
communication 

Full netw ork access 

The app will use your network communication to connect to the internet. 

Your personal 
information 

Read calendar events plus 
confidential information 

The app reads your calender events to scan for upcoming meetings and display 
them in the app, enabling you to join with a single touch. This information is used 
solely to make joining a session easier and quicker. 

Microphone 

Records audio 

The app will use your microphone to share your voice with others in the meeting. 
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Audio Settings 

Change your audio settings 

The app uses information in your audio settings to provide you with optimal audio 
by switching to different audio settings and controlling your audio devices. 

System Tools 

Send sticky broadcast 

The app uses your system tools to connect to your audio via Bluetooth devices. 

Network 
communication 

View  network connections 

The app uses your network communication information to see whether you're 
connected to the internet and to handle network disconnections. 

Affects Battery 

Prevent phone from sleeping 

The app will keep your screen from locking when you are viewing a presenter's 
screen. 

Mobile Feature Comparison 
The GoToWebinar mobile apps offer different features depending on the device's operating system. Use 
the chart below to see what is available on each app for iOS, Android and Windows devices. 

Features  iOS  Android 
Join a webinar   
View shared screen   
View and rearrange webcams  

 (iPad only) 
 

Raise your hand   
Answer polls   
Ask questions   
Leave a session   
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FAQs 
Roles FAQs 
Review frequently asked questions on roles in GoToWebinar FAQs. 

What is an organizer? 
An organizer has a GoToWebinar account and schedules, starts, manages and ends a session. An 
organizer can also designate other attendees to be organizers or panelists. Once a session starts, the 
scheduling organizer is the default presenter and may either begin presenting or pass the presenter 
controls to another organizer or panelist. 

What is a panelist? 
A panelist is a person who presents and/or answers questions assigned to him or her during a session. A 
panelist can be given the presenter controls at any time during the session and is able to speak on the 
conference call by default. Panelists do not need to have GoToWebinar accounts to participate in web 
events. 

What is a presenter? 

A presenter is the person who is presenting their screen to the audience. The GoToWebinar organizer is 
always designated as the initial presenter. The presenter role can then be passed to another organizer, 
panelist or attendee. 

Presenters can show their complete desktops, a clean screen (with no icons or taskbar) or a specific 
application window to the audience. Presenters may choose to pause Screen Sharing at any time. 
Presenters may give other organizers or panelists the ability to control their keyboard and mouse. 

What is an attendee? 
An attendee is someone who can view the presenter's screen but is initially muted on the conference call 
to minimize background noises that would detract from the presentation. If you're using integrated audio 
conferencing, the organizer can unmute up to 25 participants (including panelists and other organizers), 
whether they're using telephone or Mic & Speakers (VoIP). If additional attendees need to speak, a 
corresponding number of unmuted participants will first need to be muted (only 25 participants may be 
unmuted at any time). You can also make an attendee a panelist so that they may speak during the 
session. 

Attendees do not need to have GoToWebinar account to participate in web events. 

How many people can speak on the call at once? 
When using integrated audio conferencing, up to 25 participants  can be unmuted and speak on the call 
at any one time. 
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HDFaces Video Conferencing FAQs 

How is HDFaces different from other web conferencing video solutions? 
We provide the highest resolution video conferencing quality currently available among web conferencing 
providers – up to 6 streams at 640p x 480p for a maximum resolution of 1920p x 960p. Best of all, there's 
no additional cost to use HDFaces with GoToMeeting! 

What are the system requirements for HDFaces video conferencing? 
• Internet connection with cable modem, DSL or better 
• Windows® 8, 7, Vista, XP or 2003 Server, or Mac OS® X 10.6 Snow Leopard® or later 
• Dual core 2.4GHz CPU or faster with at least 2 GB of RAM 
• Internet Explorer® 7.0 or later, Mozilla® Firefox® 3.0 or later, Google Chrome 5.0 or later or 

Safari® 3.0 or later 
• 700 Kbps or more bandwidth recommended per participant for simultaneous screen sharing, audio 

and video conferencing 

Which webcams are recommended? 
Video conferencing will work with most standard video conferencing webcams. From our testing, we 
highly recommend the following webcams: 

• Logitech® HD Pro Webcam C910 
• Logitech HD Webcam C510 
• Logitech HD Webcam C310 

Which webcams are unsupported? 
HDFaces video conferencing does not support the following webcams: 

• 4eyeGrab 
• Hava Remote Video Device 
• Hava Video Device 
• BT878 VfW to WDM mapper (32-bit) 
• Live! Cam Notebook Pro (VF0400) 

If 6 video streams are being shared and I turn off my video stream, can another 
participant share their video? 

Yes, panelists and organizers can stop and share video streams at any time. Organizers can also disable 
a panelist video stream so that another panelist can share their webcam. 

Can I temporarily stop my webcam without giving up my webcam slot? 

Yes. You can pause your webcam temporarily by clicking the Pause button  on the top-right corner of 
your webcam feed. 
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Is HDFaces available on GoToWebinar and GoToTraining? 
Yes! HDFaces video conferencing is available for GoToMeeting, GoToWebinar and GoToTraining at no 
additional cost.  

How do I set up my webcam to use with HDFaces video conferencing? 
Install your webcam using the manufacturer's installation instructions. You can set your webcam settings 
from GoToWebinar Preferences. We recommend using a headset with mic and speakers (VoIP) instead 
of your webcam's built-in mic and speakers. 

What happens if I install a webcam during an HDFaces session? 
In most cases, we should be able to detect your new hardware and allow you to use it during the same 
session. 

What are the bandwidth requirements for HDFaces? 
We recommend 700Kbps or more per participant for simultaneous screen sharing, audio and video 
conferencing. HDFaces uses bandwidth optimization to make the best possible use of any available 
bandwidth. If you experience slow performance issues, try closing data-intense applications like 
YouTube, Netflix, Skype, etc. 

What is the supported video frame rate? 
HDFaces supports up to 30-frames/second. The frame rate depends on your webcam, lighting, network 
and computer. 

Can I join an HDFaces session from an Android or iOS device?  
Yes. You can join HDFaces sessions as an attendee, but you'll be unable to view or share webcams and 
show your screen if you're using an iPhone or iPod Touch. If you're on anAndroid or an iPad 2 or newer, 
you can share and view webcams in meetings. In a webinar, you can only view webcams from an iPad.  

Can I view webcams if I join an HDFaces session from an Android or iOS device? 
• If you are joining an HDFaces session from an Android, you will be able to view webcams. 

However, you will not be able to share your own. 
• If you are joining an HDFaces session from an iPhone or iPod touch, you will not be able to view 

webcams. However, if you are joining from an iPad you will be able to view webcams.  

What are some video conferencing tips and best practices? 
• Secure your webcam on your computer to make sure it's stable and won't move around. 
• Choose a location with adequate lighting. If you're sitting directly in front of a window, try moving to 

another spot; otherwise, your webcam may only capture your silhouette. 
• Position your webcam so that your entire face fills up at least half of your webcam viewer. 
• For optimal performance, open Preferences > Webcam > Advanced. If you have a high-

performance webcam, you can enable high-quality features, such as "face recognition" or "right 
light," to enhance your video conferencing experience. 
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How do I select a different webcam if I have more than one plugged in to my 
computer? 
To select a different webcam, open Preferences > Webcam. If more than one webcam is detected, 
simply choose which webcam you'd like to use from the Your Camera section. 

Can I record webcams during an HDFaces session? 
Although you can record screen sharing and audio, you cannot record webcams at this time. 

Why can't I see other participants' webcams? 
Your webcam viewer may be minimized, but you can bring the viewer back up again from your taskbar or 
dock. If you previously selected the Hide Webcams from the Webcams drop-down menu, select Show 
Webcams. Only staff members can show their webcams. 

Why can't other attendees see my webcam? 
Double check to see if your webcam is connected to your computer and then try clicking the Share My 
Webcam button if you haven't already done so. To see if your webcam has been detected, open 
Preferences > Webcam. 

What should I do if I'm experiencing poor video quality? 
Make sure you have adequate lighting in your room. If you have low bandwidth, you should make sure 
you have nothing else running that might use up bandwidth. If your webcam is out of focus, turn off the 
auto-focus setting on your webcam. You can also check to see if you're using one of our unsupported 
webcams. 

What should I do if my webcam stops working? 
If you have low bandwidth or CPU issues, you may see a "Low Bandwidth" or "Computer Overloaded" 
message. You'll be prompted to hide all webcams and/or stop sharing your own webcam. If you click Yes, 
all webcams and/or your own webcam will be hidden. 

To improve bandwidth and CPU performance, close all other programs on your computer, and switch to a 
high-speed cable Internet connection (if you haven't already). 

Can attendees share webcams? 
No, only organizers and panelists can share webcams. If you want an attendee to share a webcam you 
may promote them in-session to a panelist or organizer, which will give them the ability to share their 
webcam. 

GoToWebinar Features FAQs 
Review frequently asked features questions. 

How do I customize my registration page? 
On the Manage Webinar page, click Edit in the Registration Setup section to manage registration: 
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• Add additional registration fields (first name, last name and email address are always required) 
• Create your own registration questions 
• Set the approval process 
• Set up registration notification emails 

How do I monitor my attendees during a session? 

Using the GoToWebinar Dashboard, you can easily check attendance patterns and monitor attentiveness 
by viewing the status bars at the top. Green bars indicate 100% session attentiveness, yellow bars 
indicate mediocre attentiveness and red bars indicate lack of attentiveness. You can also see the number 
of open questions and hands raised at any time. 

What's the difference between Chat and Q & A? 
The Chat feature allows organizers to send private messages to panelists or broadcast messages to all 
attendees. The Q & A feature allows attendees to type and send questions to organizers and panelists 
who can respond with answers privately or to the entire audience. 

How do I save Q & A sessions? 
Question and answer sessions are automatically saved and ready for viewing in the Attendee Report 2 
hours after the session's scheduled end time.  

Can I allow a co-presenter to help me with a session? 
Yes. Organizers may invite additional presenters to a session as panelists. During a session, panelists 
are able to speak to the audience or share content from their own computers. 

Can I approve registrants before allowing them to attend? 
Yes, you can change your registration settings from automatic approval to manual approval so that you 
can view all registrants and either approve or deny them before they receive a confirmation email with 
instructions on how to join the session.  

Can I draw on and highlight screen content during a presentation? 
Yes. GoToWebinar allows organizers and panelists on Windows computers to use Drawing Tools to 
highlight and annotate their presentation. These tools include highlighter, pen, spotlight and arrow 
functions. 

Can I conduct Polls and Surveys of my attendees? 
Yes. Organizers can create Polls and Surveys before the session begins on the Manage Webinar page. 
GoToWebinar organizers can also launch on-the-fly Polls during a session and include a Survey 
immediately after the session or in attendee follow-up emails. 

Can I upload PowerPoint® presentations? 
With GoToWebinar's screen-sharing technology, there's no need to upload your presentation before your 
event. Just run it on your desktop and share your screen. 
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Can I take control of attendee desktops? 
Yes, but only if they give you permission. To take control of an attendee's keyboard and mouse, they 
must be the active presenter. 

How do I share one application and nothing else? 
A presenter on a Windows computer can share a single application, program, monitor or window by 
clicking the Show My Screen button on the Control Panel and then selecting which application to share. 

Security FAQs 
Review frequently asked security questions. 

How secure is GoToWebinar? 
Your sessions are completely private and secure. All of our solutions feature end-to-end Secure Sockets 
Layer (SSL) and 128-bit Advanced Encryption Standard (AES) encryption. No unencrypted information is 
ever stored on our system. 

How do I use GoToWebinar with firewalls? 
Our solutions use HTTP outbound connections to transparently enable screen-sharing sessions, even 
with corporate firewalls in place. In most cases, organizers and attendees can connect to Citrix Online's 
servers without re-configuring firewall settings. 

Can my computer get a virus from downloading the software or attending a 
session? 
No, neither organizers nor attendees can catch or be exposed to viruses from downloading our software. 
We continuously monitor our development environment for viruses and malware, and all of our 
downloadable software is digitally signed to prevent tampering by third parties. The warning message 
customers might see when they install the software is a default message displayed by their browser 
whenever they download executable files. 

Do I need to set my browser to accept cookies to use your website? 
You can browse our website without having cookies enabled. However, if you need to log in to an existing 
account, you will need to adjust your browser's privacy settings to accept cookies. We primarily use 
cookies to provide you with secure access to your account. 

GoToWebinarApp for Android FAQs 
Review frequently asked questions on GoToMeeting App for Androids. 

Can I use the app to join GoToMeeting and GoToWebinar sessions? 
If you’re running Android 4.0 or higher, you can install the GoToMeeting app from the Google Play Store 
to join GoToMeeting and GoToWebinar sessions as an attendee. If you're a GoToMeeting organizer, you 
can log in and schedule and start a meeting from the app, but you won't yet be able to share your screen, 
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so we recommend making someone else who joined the meeting from a Windows or Mac the presenter 
or co-organizer. 

We recommend using devices with a 1Ghz processor or higher for optimal performance. 

How can I download the GoToWebinarapp? 
You can download the GoToMeeting app from the Google Play Store by logging in to your Google 
account that's linked with your Android device and searching for the GoToMeeting app. If you don’t see 
an Install button, you may not be running Android 4.0 or higher (the minimum system requirement 
needed to install the GoToMeeting app).  

You can also download the GoToMeeting app from the Amazon Appstore (only available in the U.S.), 
which lets you instantly download the GoToMeeting app to an Android device. 

What are the minimum system requirements for joining a GoToMeeting or 
GoToWebinar session from my Android device? 

• Android 4.0 or higher 
• 1 Ghz CPU or higher recommended 
• WiFi or 3G connection (WiFi and headset recommended) 
• Free GoToMeeting App from Google Play or Amazon Appstore 

How do I join a meeting on my calendar from the app? 

Meetings in the Android Calendar app sync with the GoToMeeting app so you will see a list of your 
upcoming meetings on your Join screen. You can quickly join a meeting by tapping the name of the 
meeting. 

 

You will also see a GoToMeeting widget that displays your upcoming meetings. You can tap the meeting 
to view the meeting information, and tap Join to join the meeting.  
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Can I schedule meetings from the GoToMeeting app? 
Yes, you can schedule meetings from the GoToMeeting app by tapping the Schedule a Meeting button. 
You can then select whether or not is a recurring meeting, choose the audio and edit phone numbers. 
You can also edit meetings and invite others from the GoToMeeting app.  

Can I host GoToMeeting and GoToWebinar sessions on the app? 
You can log in to schedule or start instant or existing meetings from your Android smartphone or tablet, 
but you won't be able to share your screen. We recommend making someone else who joined the 
meeting from a Windows or Mac the presenter or co-organizer from the Attendee List. Unfortunately, you 
can't start GoToWebinar sessions from your Android device at this time. 
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What are some of the unsupported GoToWebinar features? 
Organizers and panelists can't do the following: 

• Host or join a GoToWebinar session 
• Join a session from a panelist invitation email 
• Present as a panelist or organizer 
• Start Screen Sharing 

Attendees can't do the following: 

• Start Screen Sharing or accept Presenter Control 

Can I record a session from my Android? 
No, you cannot currently record sessions from an Android device. 

Can I chat from the app? 

Yes, all attendees, organizers and presenters in a meeting can chat by tapping the Chat icon  in the 
toolbar, entering a message and tapping Send. You can choose to chat with everyone in the meeting or 
privately with another person in the meeting. When you receive a Chat message, the Chat icon will 
bounce in the keyboard toolbar.  

Chat is currently unsupported for GoToWebinar. 

Why do I see an “Unable to Join the Meeting” error telling me that the Meeting ID 
is invalid? 
If you manually entered the Meeting ID, double check to see that you typed it correctly. 
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Why do I have to enable cookies to join? How do I enable cookies on my 
browser? 
If your browser is set to disable cookies, you must first enable cookies before you can join a session. To 
enable cookies, go to your browser's settings and select Accept Cookies.  

I prefer to dial in to the audio conference by telephone. Where can I find the Audio 
PIN? 
You do not need an Audio PIN to dial in to the audio conference by telephone. To dial in to the audio 
conference by telephone, you can set your default audio to Phone by going to the Settings tab and 
selecting the Phone icon  next to Default Audio. If your default audio is set to Phone and you join a 
meeting from an Android device, you will be automatically dialed in to the meeting.  

You can see if you are connected to the meeting by VoIP or telephone in the Audio tab. If the organizer 
has provided dial-in phone numbers, you can switch to telephone by tapping Switch to Phone in the 
Audio Tab. In the Audio tab, you'll see a list of phone numbers associated with the session. If the 
organizer provides international country numbers, you can choose which country you want to dial into. 
Once you tap Dial, you will automatically dial in to the conference from your Phone app and will need to 
navigate back to the GoToMeeting app to return to the session.  

Why am I disconnected from GoToMeeting when I try dialing in from my phone? 
If you’re using a device that doesn’t allow simultaneous data and voice sharing (CDMA), you must 
connect to the Internet from a WiFi network to dial in using the same device you use to join the session; 
otherwise, you’ll be disconnected from GoToMeeting. If you aren’t connected to the Internet through WiFi, 
you must use your device’s mic and speakers (VoIP) or dial in with a different device to connect to audio. 

GoToWebinar App for iOS FAQs 
Review frequently asked questions on GoToMeeting App for iOS. 

What are the system requirements for using the GoToWebinarapp for iOS? 
Please see System Requirements for details.  

Are there any additional fees for using the GoToWebinarapp? 
Nope, the app is free, and there's no charge for attending GoToMeeting, GoToWebinar or GoToTraining 
sessions. But you may be responsible for any long-distance charges associated with dialing in to 
sessions by phone or any data charges that may be incurred. 

Can I host a GoToMeeting or GoToWebinar session from my iPad, iPhone or iPod 
Touch? Can I show my screen if I'm given presenter controls? 
Yes, you can log in and host a meeting from an iPad, iPhone and iPod touch with the GoToMeeting app. 
Organizers can schedule meetings, start previously scheduled meetings and even launch instant 
meetings from the My Meetings screen. Only iPad presenters can share content on-screen. At this time, 
you can't host a GoToWebinar session from an iOS device.  
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Can I schedule meetings from the GoToMeeting app for iOS? 
Yes, you can schedule meetings from the GoToMeeting app for iOS. You can invite attendees to these 
meetings, edit the audio and create a meeting password from the GoToMeeting app. Also, you can delete 
meetings from the My Meetings screen.  

Can I join a GoToWebinar session as a panelist? 
No, you can't join a session as a panelist on an iPad, iPhone or iPod Touch. 

Can I record a session from my iOS device? 
No, you can't currently record sessions from an iOS device. 

Can I be made presenter during a webinar on an iPad? 
No, not at this time. 

How does attending a GoToMeeting or GoToWebinar session on an iPad, iPhone 
or iPod Touch compare with the experience on a Windows or Mac? 
Just as on a Windows or Mac, you can view the presenter's screen, see who's attending and who's 
talking. However, some organizer features are not yet available on the iPad, iPhone and iPod Touch. 

Unsupported features for GoToWebinar on iOS: 

• Drawing tools 
• Presenter controls 
• Keyboard and mouse controls 
• Start sessions 
• Schedule sessions 

Unsupported features for GoToMeeting for iOS: 

• Keyboard and mouse controls of the presenter's desktop 

How can I change the view or zoom into the presenter's screen? 
You can view the presenter's screen in both portrait and landscape mode. You can also double-tap 
anywhere on the GoToMeeting Viewer to change the display to Fill Screen mode. Double-tap a second 
time to zoom in to 100% mode. Double-tap a third time to return to the default view – Entire Screen mode. 
You can also pinch or expand with 2 fingers, and pan to different parts of the presenter's screen by 
dragging 1 finger across the GoToMeeting Viewer. 

Can I chat with other meeting participants? Can I ask questions during a 
webinar? 
During a meeting or training, you can tap Chat in the toolbar to instantly send and receive messages to 
everyone in the meeting, to only the organizer(s) or to individual attendees. You can toggle between 
meeting participant names in the Attendee List to read and send messages. 
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During a webinar, you can tap Questions in the toolbar to send questions to the organizer. You can also 
view other attendees' questions and answers if the organizer sends the response to everyone in the 
webinar.  

Can I connect to audio from the GoToWebinar app? 
If the organizer provides both mic and speakers (VoIP) and conference call numbers as audio options, 
you'll automatically connect to VoIP over your iPad, iPhone or iPod Touch’s Internet connection (WiFi or 
3G) once you join. The audio quality depends on the quality and bandwidth available on your WiFi or 3G 
network (WiFi recommended).  

You can dial in by telephone on your iPad, tap the Settings icon > Audio Settings > Telephone to 
access the conference call information.If you want to dial in on your iPhone, tap the Settings icon > 
Meeting Information > Phone Number link to automatically connect to audio. With a single tap of a U.S. 
telephone number, the conference call number, access code and Audio PIN are automatically dialed. 

If you have an iPhone 4 or 4S on a network that does not allow simultaneous voice and data sharing 
(CDMA), you won’t be able to connect to GoToMeeting and dial in on your iPhone at the same time. To 
connect to audio, you should use your iPhone’s Internet connection (WiFi or 3G) or dial in with a different 
device. 

Why can't I switch from Telephone to Mic & Speakers (VoIP)? 
Once you dial in to the audio conference by telephone, Mic and Speakers (VoIP) becomes disabled for 
the remainder of the session. If you want to switch back to VoIP, you will need to leave the session and 
rejoin. 

Why can't I connect toGoToWebinar and dial in by telephone on my iPhone? 

If you have an iPhone on a network that does not allow simultaneous voice and data sharing (CDMA), 
you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to 
audio, you should use your iPhone's built-in mic and speakers (VoIP) or dial in with a different device. 

If the organizer only provides a conference call number as the audio option and you try to dial in to the 
audio conference from a CDMA network without having a WiFi connection, you'll see a notification saying 
that your device does not support simultaneous voice and data sharing. Once you tap the Dial button on 
the notification, you won't be able to see the presenter's screen.  

What audio options does the GoToWebinarapp support? 
• iPad, iPhone or iPod Touch's built-in mic and speakers (VoIP) 
• iPad, iPhone or iPod Touch's built-in mic along with external headphones connected via the 3.5-

mm stereo headphone jack 
• Headset connected via the 3.5-mm stereo headphone jack 
• Bluetooth Hands Free devices 

For optimal audio quality, we recommend using a headset. 

Can I join HDFaces meetings and webinars from an iPad and view webcams? 
Yes, you can join HDFaces meetings and webinars and view webcams from an iPad. You can share your 
own webcam in a meeting from an iPad 2 or newer, but you cannot yet share your own webcam in a 
webinar.  
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